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Despite our best efforts, when computers, software, printers and color management come

together, somewhere along the line problems may occur. This guide will help to solve the

majority of issues that users run into as well as answer common questions regarding the
use of ImagePrint BLACK and ImagePrint R.E.D..

Note: This guide is designed for users of ImagePrint BLACK and R.E.D. and may not
apply to earlier versions of the software. Users of most previous versions can access
trouble-shooting in the back of their user’s manual or as a separate PDF file within their
ImagePrint folder.

The latest revision of this guide is always available on the Technical Support page on the
ColorByte web site: www.colorbytesoftware.com
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Contacting Technical Support

Most issues with ImagePrint can be solved by consulting this Troubleshooting guide, however, there are times you
need a helping hand to get past some problems. For that, there’s ColorByte’s technical support department.

ImagePrint R.E.D. comes with 90 days email support.
ImagePrint Black comes with 1 year email and phone support.

ColorByte’s email support is among the best in the business, and responses are typically quick and accurate. (In
fact, email response times are often much quicker than those for phone calls).

Please consult the following guidelines when corresponding with our support dept. to receive a solution to your
problem more quickly. ColorByte’s support dept. can be reached via an email link by going to www.colorbytesoft-
ware.com and choosing Support from the IP RED or IP BLACK menus at the top of the screen. You can also email
support directly at: support@colorbytesoftware.com

Please remember: If you are not on the current version of ImagePrint or under a maintenance
contract you may no longer be eligible for support. If unsure of your support status, please con-
tact the ColorByte Sales dept. at sales@colorbytesoftware.com.

Introducing the IP Diagnostic Utility

The ImagePrint Diagnostic Utility is a stand-alone program that can help you diagnose and fix common
issues that may occur with the software. It also includes the ability to create a Diagnostic Snapshot that can
be uploaded or emailed to ColorByte Software. Sending a snapshot is often the best and quickest way for
ColorByte Software’s Technical Support team to determine the cause of the problem you’re experiencing.

To generate a Diagnostic Snapshot, first launch the IP Diagnostic Utility from your ImagePrint folder:

\ Program Files (x86) \ ImagePrint \ IP Diagnostic.exe

After launching the utility, click the Apply button beside the: Send Diagnostic Snapshot to Colorbyte.

A snapshot will be generated containing recent job files, logs, configuration files and your computer settings.
You can choose to upload a copy of these diagnostics to ColorByte or save a copy to your desktop for attach-
ing to an email. When choosing to upload the snapshot, make sure to include your name, dongle number and

a description of the problem you're having in the provided fields--and don’t forget to email ColorByte’s Support
dept. at support@colorbytesoftware.com as they are not automatically notified when you sent a snapshot.

Emailing ColorByte Support

When emailing ColorByte Support, always include the following information:
* Your name and 6 digit dongle number
* The printer you are using and how the computer is connected to it.

* The version and build number of ImagePrint (this can be found by choosing “About” under the ImagePrint
HELP menu)

* The platform (Mac or PC) and the OS (i.e., OSX 10.5.2, or Windows 7).

Back to Table of
Contents
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Continued on next page

» A brief (but detailed) description of the problem you are having. Make sure to include any error messages
exactly as they appear. Some questions you may also wish to include answers for are:

- Is this a brand new installation of ImagePrint on this computer?
- Has anything changed on your system prior to the problem?

- How are you connected to the printer?

- Have you reproduced the problem, or did it just happen once?

- Does the problem only happen with certain images? (If possible, try printing the “sample portrait.tif’
image that is located in the Test Images folder off the ImagePrint folder as a test.)

What have you already done to try to correct the problem?

Other Information that may be helpful to include in the email:

(Note: If using the IP Diagnostic Utilities “Diagnostic Snapshot” option mentioned earlier in this
section, these items (and much more) will be included automatically)

* Job File: - This is typically the most valuable diagnostic information we can receive if you are emailing about
a problem related to printing. Job files are the files sent to spoolface when you click PRINT and contain all
the information about that print job.

To get a job file:

In Spoolface, move the print job to the finished side of the spoolface window.

Double-click the job--a text window will appear

Highlight all of the text in the window (scroll down to get it all)

Copy and paste this information into your email.

Things not to include in a support email

* Vague or very general information, such as “I get an error”, without specifying what it is. These types of
emails waste time as they invariably require another round of emails as we ask for specifics.

» Pricing and sales questions. Our support department is not able to answer specific questions on pricing.
Those are best sent to our sales dept. at: sales@colorbytesoftware.com

Support Availability

Colorbyte Technical Support is available during regular business hours: 9:00 am to 5:00 pm, Eastern Standard
Time. Most emails are responded to within 2 hours of receipt (often much more quickly) however volume received
and other factors may affect response times. If you have not received a response within 24 hours, please resend
the email. If you are no longer using the current version of ImagePrint, you may no longer be eligible for support.

If you are not on the current version of ImagePrint or under a maintenance contract you may
receive an automatic response from support detailing your support options.

Back to Table of
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Where can | go to learn more about ImagePrint?

Users Guide: The ImagePrint user’s manual is the first place to find information about the various tools and
features available within the software.

You can access the manual by choosing Manual from the Help menu within ImagePrint. The latest revision
of the manual is also available on our web site’s (www.colorbytesoftware.com) Support page. The manual is
large and comprehensive, and is often best used as a general reference rather than read cover-to-cover.

Training Movies: RECOMMENDED Sometimes you need to see a feature in action in order to understand it.
The numerous training movies located on our web site: www.colorbytesoftware.com can be incredibly useful
in that regard.

Users Group: The Yahoo ImagePrint Users Group is a great source of information about ImagePrint. Users
of the software share their advice, tips, solutions (and complaints) in an often lively discussion. Many of the
participants are long time users of ImagePrint and gurus in the ways of printing. To access the group use the
following link:

http://tech.groups.yahoo.com/group/colorbyte_imageprint/

Workshops, trade shows, seminars: While ColorByte doesn’t currently produce workshops or seminars,
there are existing ones that utilize and teach with ImagePrint. Also, ColorByte personnel sometimes appear
at industry trade shows or participate in dealer seminars. For information on upcoming events in your area,
contact the sales department at:

sales@colorbytesoftware.com

Updates: Choose Check for Updates from ImagePrint’s HELP menu to update the software to the lat-
est revision. If you need to reinstall, or install on a new system, the latest build of ImagePrint R.E.D. or
ImagePrint BLACK can be found at the ColorByte web site via the following links:

http://print-red.info
http://print-black.info

For more information on updating, see Updating ImagePrint in the next section.

Back to Table of
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Which Windows versions are ImagePrint compatible with?

ImagePrint Black and ImagePrint R.E.D. are compatible with Vista, Windows 7, Windows 8 and
Windows 10. 64-bit versions only.

If your copy of ImagePrint is incompatible with your Operating System, you will need to update the
software in order to use it on that OS. Depending on your current ImagePrint version, updates may
be free or may need to be purchased. To find out your current upgrade eligibility and applicable pric-
ing, send an email request including your dongle number to: sales@colorbytesoftware.com

The latest build of ImagePrint can be found at the ColorByte web site’s support page for your version
(R.E.D. or Black)

www.colorbytesoftware.com

For more information on updating, see Updating ImagePrint

Back to Table of
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Installation, Uninstallation Issues

This section is devoted to issues related to installing, uninstalling, or launching ImagePrint.
Re-installing your ImagePrint printer driver - A quick and easy walkthrough

Sometimes reinstalling your printer driver is the quickest solution to a stubborn problem. The IPSetup utility,
located in your ImagePrint folder, can be used to remove and reinstall your ImagePrint printer(s). Follow the
below instructions to remove and reinstall your ImagePrint printer driver.

* Make very sure that ImagePrint, and Spoolface, are NOT running (Important!)
* Launch IPSetup by double-clicking it from your desktop icon, or from your ImagePrint folder.

( C:\ Program Files (x86) \ ImagePrint \ IPSetup.exe )

» Choose any installed printers within the window by clicking them, then click the DELETE PRINTER but-
ton to remove it. (IMPORTANT--This will delete all your old print jobs on the Saved (bottom) side
of Spoolface. If you wish to keep those old jobs you may skip this step and ADD the printer
“over” the previous one without deleting it first, although that method may slightly reduce the
chances of the procedure correcting your problem)

* Choose the ADD PRINTER button.

» Since you've already entered your license number when the printer was originally installed, you can just
click Continue instead of re-entering your license number. Click YES in the Demo message window that
appears--don’t worry, it will find your previously entered license number in a later step.

* What you do next depends on whether you are reinstalling a driver for ImagePrint BLACK or R.E.D.

Reinstalling an ImagePrint R.E.D. driver
Select R.E.D. as the installation type and click Continue.
Choose Large or Desktop (depending on the driver you are reinstalling).

(Optional) If the printer you are reinstalling was given a name other than the default, you can rename
it in the field at the top of the window.

Click Done.

Continued on next page
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Reinstalling an ImagePrint BLACK driver

Select BLACK as the installation type and click Continue.

Pick your printer from the drop-down list and click Continue.

Specify if this is a HOST installation (the dongle is attached to your computer) or a CLIENT (you will be
sending jobs to another computer). In most cases, HOST is the correct choice unless you have already
installed ImagePrint on another computer and have the dongle attached to that one. Click Next.

Specify the printer connected method. There are three possible methods, depending on your printer:
1. If you are presented with a list of System Printer Drivers:

Choose the driver for your printer from the list and click DONE.
2. If you do not see a list of printer drivers and are connected via USB to the printer:

Choose “Local Port”, then click the “PORTS” button

In the PORTS SELECTION window that appears, click on the manufacturer’s driver (for
instance, EPSON STYLUS Pro 4800) on the left.

Click OK to close the Port Selection window, then click DONE.

If you do not see a list of system printer drivers and are connected via ETHERNET or WIFI (network) to
the printer:

Click the NETWORK button, and enter the IP Address of the PRINTER in the field provided. (If
you do not know the printer’s IP Address, consult the Networked Printer Settings section later
in this guide).

Click Done.

Your re-installed printer should now be listed in the IP Setup window, with LICENSED shown beside it.

Consult the appropriate section of this guide if a problem or error occurs with any of the above proce-
dures.

T
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Installer fails to complete
If the Installer fails or never launches, check the following for possible causes and solutions:

Anti-Virus software: Failure to complete the installation may be caused by Virus detection software. It is
strongly recommended that you disable any anti-virus software during installation. RIP software such as
ImagePrint alters system files in ways that often seem suspicious to anti-virus software and may trigger blocking
or quarantining of necessary files. If anti-virus software is enabled during installation of ImagePrint, make sure
to ALLOW any components the anti-virus software may prompt you to block.

Permissions: You may also see this error if there is a permissions issue that prevent the installer from writ-
ing to the necessary folder (c:\program files(x86)). Try right-clicking the installer and choosing to “Run As
Administrator”.

Disk space: It is also possible that there is insufficient disk space to complete the installation (ImagePrint
requires approx. 200 megabytes of disk space.

Can’t uninstall ImagePrint

To uninstall ImagePrint, make sure ImagePrint and spoolface are not running. Then, go to your Windows Control
Panel and choose “Programs and Features” (if on Windows 7 or 8) or “Apps and Features” (if on Windows 10). You'll
see Imageprint R.E.D./Black in the list of programs to uninstall.

After double-clicking the ImagePrint R.E.D./Black entry, you'll be prompted to Repair or Uninstall. Choose Uninstall to
remove the software. You'll be given a choice to remove User settings and spooler files as part of the uninstall pro-
cess--if you choose to remove those files, old jobs and settings will not be preserved if you reinstall ImagePrint later.

If after uninstalling you find that the ImagePrint folder still exists in the “Program Files (x86)” folder on your hard
drive, it will likely be because the ImagePrint background process, MUXD, is preventing the uninstaller from remov-
ing the folder. Follow the procedure later in this manual: Killing the Muxd background process, then try deleting the
ImagePrint folder manually by dragging it to the trash.

If you still have problems with the Uninstaller, you can manually uninstall ImagePrint using the procedure in the next
section, Manually Uninstalling ImagePrint.

Manually Uninstalling ImagePrint
If the Imageprint Uninstall fails, you can manually remove ImagePrint by following these steps.

Step 1: Make sure no ImagePrint related programs are running. Make sure ImagePrint and Spoolface are closed, and
then kill the MUXD.EXE background process via the Windows Task Manager according to the following procedure:
Killing the Muxd background process.

STEP 2: Go to / Program Files(x86) /ImagePrint, and double-click the “ImagePrint USER DATA folder” shortcut.
Move up one directory level (you will be in a folder called “ColorByte Software” and there, delete the folder called
ImagePrint. This will remove all your settings and old print jobs.

STEP 3: Go to the folder: / Windows / SysWow64 and delete the file “libiccdll.dll” if it is there. NOTE: You may
need to adjust your window settings to Show Hidden System Files if you do not see any “dIl” files in this folder.

STEP 4: Delete the ImagePrint folder from its location in the “Program Files(x86)” folder of your system (default: c:\
program files(x86)\imageprint)

STEP 5 (OPTIONAL): You can now delete any shortcuts on your desktop and the Windows Start Menu related to the
software.

Back to Table of
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Killing the MUXD background process

The background process “muxd.exe” is a vital component required for printing. When ImagePrint is installed,
that process is configured to launch each time your computer is started, and it will remain running in the back-
ground. Because the process is always running, it may prevent you from deleting the ImagePrint folder when
uninstalling the software. If that happens, you may need to manually end the process via the Windows Task
manager via the following procedure.

Launch the Task Manager by pressing the Control->ALT->Delete keys on your keyboard, and choose TASK
MANAGER in the window that appears.

In the Task Manager, choose PROCESSES, and look for MUXD.EXE among the active processes.

Highlight the MUXD.EXE listing, then click the “End Process” button to end it (Click OK if a warning message
appears).

Close the Task Manager

How do | update/upgrade my software?
Already on ImagePrint R.E.D. or BLACK?

Updating ImagePrint R.E.D. or Black is easy. The latest update of ImagePrint is always available from within the
software via the Help -> Check for Updates command in the Main menu.

If, for some reason, the UPDATE process does not work (or you are not connected to the internet on your
ImagePrint computer) you can manually download the current ImagePrint Installer and apply it. Running the
Installer on top of a current installation of ImagePrint R.E.D. or Black will update it to the latest revision without
affecting your settings or job files.

To get the latest installer, go to www.colorbytesoftware.com and choose IP RED or IP Black from the menu at
the top of the screen. Choose SUPPORT from the drop-down menu to access the Support page for your ver-
sion of the software, from which you can download the installer.

Upgrading from an older version of ImagePrint?

I IMPORTANT: Do not upgrade to ImagePrint BLACK or R.E.D. if you do not already have an ImagePrint
license for the new version or the software will run in demo mode (putting the word DEMO on your
prints). Please contact the ColorByte sales dept. at sales@colorbytesoftware.com with your 6 digit don-
gle number for information and pricing on upgrading to Black or R.E.D.

- Upgrading from ImagePrint 10 to ImagePrint Black

On Windows, to upgrade ImagePrint 10 to ImagePrint Black you can use the ImagePrint R.E.D./Black install-
er--it will update the software to ImagePrint Black while attempting to preserve old job files and your installed
printer(s) though some settings may need to be reapplied. To get the latest installer, go to www.colorbytesoft-
ware.com and choose IP BLACK from the menu at the top of the screen. Choose SUPPORT from the drop-
down menu to access the Support page for ImagePrint BLACK, from which you can download the installer.

Back to Table of
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- Upgrading from ImagePrint 9 or earlier to ImagePrint BLACK

Upgrading on top of a previous ImagePrint 9 or earlier installation is not supported on Windows. You
must remove ImagePrint 9 or earlier prior to installing ImagePrint BLACK. Follow the uninstall instruc-
tions in your ImagePrint Users Manual for the version of ImagePrint. Then install ImagePrint BLACK
using the instructions in your ImagePrint Black shipment or download email.

- Upgrading from earlier versions of ImagePrint to ImagePrint R.E.D

You can not update older versions of ImagePrint to ImagePrint R.E.D. ImagePrint R.E.D. requires

a clean install. Follow the uninstall instructions in your ImagePrint Users Manual for the version of
ImagePrint. Then install ImagePrint BLACK using the instructions in your ImagePrint Black shipment or
download email.

Networked Printer Setup -- Getting your Printer’s IP Address (and other network settings)

If installing an ImagePrint BLACK printer as a network (Ethernet or wifi) printer you may need to specify the IP
Address of the printer. The following information is taken from the Appendix of the ImagePrint manual.

Getting the Printer IP Address

When printing to a printer via an Ethernet or wifi connection, the TCP/IP communication protocol will be used. This
protocol depends on each device on the network having a valid, unique IP Address.

For some printers you will need to provide the IP Address of the printer to IP Setup during installation so
ImagePrint can communicate with it at print time. This is usually done on the printer--although different printers
vary in the exact steps, some method of accessing the ip address will be available.

Front Panel: Most printers allow you to see and specify the IP Address via the front panel controls on the printer.
Consult your printer’s manual for instructions for how to do this.

Status Page: In cases where you are not able to use the front panel to set the IP Address, check for a small or
recessed button beside the port where the network cable plugs into the printer. Pushing this button for one second
will cause most printers to output a page showing their current settings, including the IP Address. (Make sure to
load scrap paper on the printer--not expensive art paper!)

The IP Address will consist of 4 numbers, each between 0 and 255, separated by periods. This is the number you will
need to use in the Network fields when installing the printer with IPSetup.

Checking TCP/IP connectivity

Once you have the printer’s IP Address, type it into the address field of a web browser (like Internet Explorer,
Chrome, Safari or Firefox). Just type the 4 numbers of the ip address, separated by periods, into the address field-
-no other text (like http://) is needed. You should see the Printer's HTML setup screen. Using a web browser in this
way is a good test of your computer’s TCP/IP connectivity to the printer--if the browser fails to show the printer’s
setup screen, then you know you have a TCP/IP communications problem.

Different IP Address sub-nets between printer and computer (usually only on “big” networks):
Communication problems can arise if the IP Address numbering scheme of the printer is different than that of com-
puter. For example, if the printer’s IP Address is: 192.168.0.12, and your computer’s is 30.40.16.8, then it is likely

Back to Table of
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there will be no communication via TCP/IP between the devices. Compare the IP Address of your computer to that of
your printer. If the first 3 sets of numbers are not the same, this may be the problem (the last number should always
be unique for each device). In cases where the network schemes differ, you may not be able to communicate with the
printer until the IP Address is changed to one that is compatible with the rest of your network.

You can check the ip address of your computer on Macs via the Network Control Panel in System Preferences, on PC'’s it
is available in the TCP/IP properties of your network card or by typing “ipconfig /a” in a DOS (command) prompt window..

Network Printer Settings (Continued)

Changing the printer’s IP Address (if needed)

Front panel: If the printer allows you to change the IP Address via the front panel on the printer, changing the
address is relatively easy--consult your printer’s manual for instructions.

Manufacturer’s utility: In cases where you can’t set the IP Address via the front panel, you may need to use a setup
utility provided by the manufacturer. For Epson printers, the Net Assist utility is used to setup the network parameters
on your printer. That utility is provide on the Epson printer setup cd’s, and is also available for download from the
Epson web page.

Reset the printer to factory defaults: Another method of changing the printer’s IP Address is to reset the printer to
its factory default settings (usually done via the printer’s front panel or by holding down the recessed button on the
network card of the printer while turning the printer off, then on.) When the printer comes back up, it will default to
DHCP mode, which will cause it to get a new IP Address from the router which should then be correct for your net-
work. Output a new status page (either from the printer’s front panel menu, or by quickly pressing the network card’s
recessed button) to see the new IP Address and try to reach the again with that address in a web browser.

Setting the printer to a Manual (Static) IP Address

Once you have the printer’s IP Address (and have used it to specify the connection to the printer in IP Setup), it is
important that this IP Address doesn’t change in the future. Otherwise, ImagePrint will no longer be able to find the
printer. An IP Address that doesn’t change is called “Static” or “Manual”.

To set your printer to a Manual IP Address, log into the printer via a web browser as described earlier in this section
by putting the IP Address of the printer into the browser’s address field and pressing the return key. If the printer is
reachable on your network, you should get a login window, with access to the printer’s configuration settings.

Once you are on the printer’s setup page, you need to specify the “Method for Acquiring the IP Address”. For
most printers this setting is in the TCP/IP portion of the Configuration section of the Printer Setup window, however
the specific location and terminology may vary for some printers. The choices are typically: AUTO or MANUAL
Make sure it is set to MANUAL to prevent the IP Address from changing each time the printer is restarted. After
changing the setting (if necessary) apply the settings--usually that is done via the SUBMIT button at the bottom of the
setup screen.

Note: Most printer setup screens will ask for a user name and/or password when applying new settings. Unless you
have previously set a password for your printer, the entries should be left blank for most printers as that is the default
username and password. If that fails, try using the name “admin” for the username and nothing for the password.

Back to Table of
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License, Dongle and Demo Mode Issues

ImagePrint licensing problems and solutions are listed in this section
How do | get my license number?
In order to enable your software to print in non-demo mode, you must first license it.

Licensing is done via a license (sometimes called “encryption) number that is 19 to 20 digits in length. This number
is specially made for your unique dongle number and the printer(s) you are using with ImagePrint. It can be entered
into the LICENSE field of IPSetup when installing the printer or entered later by launching IPSetup and clicking the
LICENSE button. In IPSetup your printer will be labeled as “Licensed” and you'll be ready to print.

To get your license number, you must use the ColorByte license server web page. This server is available on the
internet 24 hours a day, 7 days a week.

To use the ColorByte license server you will need 3 things:

1. Your unique 6 digit dongle number.

This number is provided on the dongle itself, as well as on the label on the back of your software cd case (if you
received a cd). It will also be listed in any upgrade emails you receive from ColorByte.

2. The 6 letter login code for each printer type you will be using with ImagePrint.
This login code can be found in your ImagePrint shipment or in the upgrade email you received from ColorByte.

Remember--login codes are specific to the version of ImagePrint you are using--do not use an older login code
to get a license number for a later version of ImagePrint or you will just re-receive the previous versions license
code and it will fail to license the software.

If installing multiple printers you'll get a separate license for each printer size but-- if you have purchased mul-
tiple printer licenses for the same size of printer (for example, two 17 inch printers such as a Canon Pro 1000
and an Epson 5000) then you will be provided one single login code that is good for two printers.

3. A valid email address

Log on to the ColorByte license server by going to the colorbyte web site (www.colorbytesoftware.com) and choos-
ing either IP RED or IP BLACK from the menu at the top. In the drop-down menu that appears, choose “Activate
Software” to access the license activation web page.

You will be taken to a page containing fields for the 6 digit dongle number, the 6 letter login code, and the email
address the license number should be sent to. After filling out those fields, click Submit to have the license number
emailed to you. You will usually receive the email within 1 minute.

If you don’t receive the email: Check for any junk mail filters on your computer or in use by your Internet Service
provider---in almost all cases, instances where the encryption email is not received are due to it being misinterpreted
as junk (spam) mail by such systems.

There is no limit to the number of times you can use the encryption server, and you can use it with a different email
address if you have problems with your original email one. Just make sure to use the right login code for your version of
ImagePrint (i.e., don’t use your version 7.0 login code if installing version BLACK).

Continued
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The Dongle number is not seen in IPSetup. “NO DONGLE FOUND” displayed at the top.

If the 6 digit dongle number does not appear at the top of IPSetup, try plugging the dongle into a different
USB port, or a USB hub if available. Make sure to quit and restart IP Setup after trying a different port so it
will recheck for the dongle.

Regarding the dongle light.

The red dongle “pin hole” light does not stay on all the time so not seeing the light is not necessar-
ily an indication that the dongle is malfunctioning.

If the dongle number still fails to appear after trying a different port and restarting IPSetup, there may be
a problem with the Windows dongle driver. Sometimes Windows will attempt to put its own driver in place
when it senses the dongle and that can cause issues.

You can check if the dongle drivers have been installed correctly by opening the Windows Device
Manager. (On Windows 10, right click the Windows START menu and choose Device Manager from the
menu that appears. For other versions of Windows: Choose Control Panels from the Windows Start menu,
then System, then click Hardware, then the Device Manager link).

The dongle will usually show up under the name CBUSB within the USB (Universal Serial Bus) section of
the Device Manager. If there is a question mark, or exclamation mark, beside the USB entry for the dongle
in the Device Manager, the dongle drivers have probably been incorrectly installed.

To reinstall the dongle drivers:

* Right click the driver showing a question mark or exclamation point and choose “Uninstall” in the menu
that appears.

* Remove the dongle from the computer.
* Reboot.

* Once the computer is back up, open the c:\program files(x86)\ImagePrint folder on your system, then
open the License folder, then the Marx folder. Run the CBSetup program in that folder by double-click-
ing it. When prompted, specify that it install the USB drivers for the dongle.

* Insert the dongle once again. The new hardware wizard should appear and should automatically find
the drivers. (If you see a warning that they are unsigned by Microsoft, click OK to ignore it). Let the
Wizard finish.

» Launch IPSetup and, hopefully, the dongle number will appear.

If the dongle still fails to appear in IPSetup, there may be a problem with the dongle, or with the USB bus
on your computer. If possible, try installing ImagePrint as a test on another computer to confirm the dongle
can still not be seen (for test purposes, no printer need be attached to the other computer--just specify any
printer within during installation).

Another thing to try: it's possible in some cases that the dongle contacts have developed an oxidized coat-
ing on their contacts preventing a solid connection to the computer. You can take a small flat head screw
driver--or even an unfolded, sturdy paperclip--and vigorously scratch the 4 contacts visible within the open-
ing of the dongle where it plugs into the computer. In several cases that has brought a seemingly dead
dongle to life.
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If none of the above attempts cause the dongle to be seen in IPSetup, the dongle may have malfunctioned (this is
rare, but can happen due to physical or electronic damage). Contact ColorByte at sales@colorbytesoftware.com

or your ImagePrint dealer in this case.

My license number isn’t accepted when | enter it in IPSetup

Until the dongle number can be seen by the computer your license can not be successfully entered.
Without a license, the software will either run in DEMO mode (printing DEMO on all output) or will

not print at all!

The IPSetup program is used to both set up and license your printers. If, after entering your license number the

installed printer(s) don’t show as LICENSED in IP Setup, check the following:

1. Make sure the 6 digit dongle number is showing within the dongle number field of the IP SETUP
window. If the dongle field shows “0”, then the system is not currently seeing the dongle. Check the entry

in this guide entitled: Dongle never seen in IP Setup; Dongle number shows 0

2. If the dongle number is showing up correctly in IPSetup, but the printer still won’t license, check
each of the following points:

Make sure you are using the right license for your version of ImagePrint.

If updating from a previous version, typically, the new license retrieval information is included when you
receive your upgrade information via email. (Do not use your old login code to receive your license
number from ColorByte’s activation web page, as it will just send you the old version’s license

again!)

If you receive NO error message but the printer doesn’t show LICENSED at the end of the printer line in

IP Setup after entering the license number, try deleting the file “ip auth”, from its location in the ImagePrint
DATA folder on your system. You can get to the DATA folder via the shortcut in the COLORBYTE
SOFTWARE program group listed in your Windows Start Menu. Once you have deleted the ip auth file, try
to LICENSE the printer again via IPSetup.

If you have more than one printer, make sure to try all of the licenses you have received. IPSetup will auto-
matically apply the correct license number to the installed printer it was created for. If that printer type has
not been installed yet, the license will be stored and automatically applied when the printer is installed.

If you have multiple printers of the same category (for instance, two 44 inch (large format) printers) then
you will have received a single “multiple printer” license. Enter this encryption in the License window as you

install each printer of that type.
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DEMO appears on all prints or NOTHING prints with red error messages appearing in the
right (status) section of spoolface

“‘DEMO” mode occurs when the dongle is not “seen” by the computer and/or the proper printer license
not being in place. In DEMO mode, NOTHING will print if you are currently set to “Not Print in Demo”
mode under spoolface’s QUEUE menu, or you'll see a DEMO watermark on all of your output if set to
“Do Print in Demo” under spoolface’s QUEUE menu.

Always check SPOOLFACE’s status area, on the right side, for licensing messages (typically in RED) to
confirm this condition).

If no red messages appear, and licensing appears to be correctly set up, yet nothing prints, then this
may be a printing problem unrelated to licensing or the dongle. See the PRINTING ISSUES section of
this document to troubleshoot.

If you do see messages in spoolface that refer to licensing or dongle issues:

1.

Make sure that an ImagePrint dongle is attached to your computer. You may want to
try plugging the dongle into another USB port, or a USB hub. You can check to see if the
dongle is being seen by launching the IPSetup program from the ImagePrint folder, and
checking that the 6 digit dongle number appears at the top of the window. If it doesn’t, see
the earlier section (The Dongle is not seen in IPSetup) on resolving issues with the dongle
not being detected.

Make sure that a valid license has been entered in the IPSetup utility.

If, even after entering the license number, the installed printer(s) doesn’t show as
LICENSED, see the entry in this guide entitled: License doesn’t work in IPSetup.

If the dongle is connected to your computer or USB hub, the printer has been licensed in
IPSetup, and DEMO still appears on prints, double-check in IP Setup that the dongle is
still seen. (Sometimes, plugging other USB devices in or unplugging them can cause the
dongle to not be seen temporarily).

If none of the above suggestions apply, its possible that the dongle drivers have been
incorrectly installed. Try the procedure listed in the previous entry Dongle number never
seen In IPSetup.

Using the IP Diagnostic Utility to open folder permissions

Some problems are caused by Windows folder permissions being changed on ImagePrint’'s pro-
gram folders (often after a Windows update). Problems reading license files or writing spool data
can occur when this happens.

To re-open permissions on these folders:

1. Find the IP Diagnostic utility in your ImagePrint folder:

c: \ program files (x86) \ ImagePrint \ IP Diagnostic.exe

2. RIGHT click the utility and choose to “Run as Administrator”

3. Click Next beside “Common Trouble-shooting Solutions”

4. Choose Apply beside “Open Permissions”.

5. Close the IP Diagnostic Utility when it reports permissions have been opened.
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Problems related to launching or using the ImagePrint interface are listed in this section

ImagePrint won’t launch

Make sure that you have set up your printers using the IPSetup utility. (You can double-check your
installation by launching IPSetup from the ImagePrint folder on your system. (Default location: c:\pro-
gram files\imageprint(x86) on Windows, and /Applications/ImagePrint on Macintosh). If no printers are
listed, then none have been installed and ImagePrint will fail to launch.

Make sure that the ImagePrint folder has not been moved or renamed. This folder must retain the
same name and location as it had after installation or the software will not run.

Make sure that you are launching the application from either a valid shortcut or directly from the
ImagePrint folder. Do NOT move ImagePrint’s application files to a different location other than the
folder they were installed to or they will NOT work.

An invalid or corrupt monitor profile may cause this condition. If you've profiled your monitor recently
test this by accessing your Windows Control Panels, choose Display, then Settings, then Advanced,
and temporarily change the System Monitor profile to a standard working space (such as Adobe 1998).
Remember the previous profile so you can return to it later. Then try launching ImagePrint again. If it
works, there is an issue with your monitor profile. Try reprofiling or using another monitor profile.

Try repairing ImagePrint via the Windows Control Panel. This can put back components that were
removed by anti-virus software and replace corrupted application files.

To repair ImagePrint: Go the Programs and Features Control Panel (on Windows 7 or 8) or the Apps
and Features Control Panel (Windows 10) and double-click the ImagePrint RED/Black entry. Choose
Repair in the window that appears. Try launching imagePrint again after repairing.

Removing ImagePrint completely and reinstalling may correct serious corruptions within the software.
Consult the ImagePrint users manual (located in your ImagePrint folder) for information on removing
and reinstalling ImagePrint completely.

Anti-virus software or other security related software has often been known to prevent ImagePrint
from launching. Try disabling such software (or, better yet, removing it temporarily as disabling often
does not fully de-activate anti-virus software) and then try launching again.

“Code Execution” error mentioning “libiccdll.dll”. This error means the ImagePrint ICC library file

is an older version than needed. Probably a previous version did not get overwritten correctly when
ImagePrint was updated to a new version. You'll need to delete the existing libiccdll.dll file, then run
the ImagePrint installer again to put the new version of that file in place. The libiccdll.dll file is located
in the SYSWOWG64 folder within your WINDOWS folder:

c: \ windows \ syswow64 \ libiccdll.dll

Delete the libiccdll.dll file, run the ImagePrint installer once more, and ImagePrint should open. (If you
don’t see dll files in that folder, you may need to set your Folder view settings to show “Hidden” files.)

Other “dll” errors. If you get an error mentioning a dll file (other than the libiccdll.dll file men-
tioned above) then a required Windows run time library may be missing. To correct the issue, find
the folder called “redistributables” within your ImagePrint folder (in Program Files (x86). Within the
Redistributables folder are a number of Microsoft Library installers. Double click each of these and
install (or repair) the libraries as prompted. Each one should take 10 to 30 seconds to complete.
When done, try launching ImagePrint again.
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Some ImagePrint windows (such as the Image Strip, Shuffle, etc) or SpoolFace not appearing
when chosen

Display Change: If you are using a new monitor with a different resolution, or have recently changed the
resolution on your current monitor, or have gone from two monitors down to one, it's possible that the window
is being placed outside of your current displayed area. To fix the problem, temporarily reset your monitor to
the old resolution and then manually move the windows back into range.

A quick fix may be simply to launch ImagePrint, and under the VIEW menu choose “Reset Window
Positions”. That will return all of the ImagePrint windows to their default locations.

If a change in your display is definitely not the problem, or it is not possible to go back to your previous
display configuration, you may need to delete ImagePrint's Registry key. Note: deleting this key will revert
most ImagePrint settings back to their defaults. Follow the procedure in this guide entitled: Deleting the
ImagePrint Registry Settings to correct the problem. Make sure that ImagePrint and Spoolface are NOT
running before deleting the registry key.

Files won’t open

Far and away, the most common problem with images failing to open is due to an illegal character in the file
name OR THE NAME OF ANY OF THE FOLDER(S) (also known as the PATH) THAT THE FILE IS IN.

For example: if your file is called test.tif, and it’s in the following folder path:
/ my files / images / photo group #2 / vacation pics / test.tif
The “#” in “photo group #2” would prevent any files within the above path from opening.

Check the name of the file (and every folder and sub-folder along the file’s path) for any character that is not
a letter, number, underline, hyphen or space. Check the entire path of folders--any problem character in any
folder in the file path will cause the image not to open. Again--don’t simply check the file name--check
each folder, and sub-folder, along the path containing the file for illegal characters. (Did we mention
that you should check the entire path?)

Problem characters include (but are not restricted to): parenthesis (), pound signs #, apostrophes ‘, amper-
sands &, commas , , dollar signs $ and bullets «. Also--make sure your files have the proper extensions
in the file name for their format. (.tif (or .tiff), pdf., .psd, .jpg) or they will not be recognized as image files by
ImagePrint. As a test, try renaming your file to a simple name (i.e., test.tif, test.jpg or test.psd) and move it
to your local computer’s desktop. Then try to open it in ImagePrint. If it opens, then either something in
the filename or pathname is causing an issue, or permissions on the original folder or drive the image was
located in was the culprit.

If the image still fails to open, check the sections of this guide pertaining to problems with the file type you are
working with (JPEG, PSD or TIFF).

Remember that ImagePrint only opens JPEG (RGB only), PDF, PSD and TIFF files. Other for-
mats such as PostScript, EPS, PNG, GIF, or Raw files are not supported.

JPEG files won’t open (or open very slowly)

» Try re-saving the JPEG file from Photoshop, and make sure NOT to use “PROGRESSIVE” as the JPEG
compression format in the SAVE dialog. Also, only RGB JPEG files are supported (not CMYK JPEG files).
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JPEG files are opening and printing at the wrong size!

ImagePrint will honor the width/size parameters of a jpeg file. Sometimes, however, JPEG files don’t have that
information (usually this happens when JPEG files are saved straight from a camera without being saved out
through an editing application like Photoshop). In those cases, ImagePrint will default to size the image at six
inches wide (if landscape) or six inches tall (if portrait). You can always quickly resize the image via the Width/
Height fields at the top of the ImagePrint Layout window, or drag an edge of the image to resize it dynamically.
Or use one of the automatic sizing options like “Fit to Page” in the Floating Toolbar.

PNG files won’t open

PNG support was added with ImagePrint Black and R.E.D. starting with build 11.0.19. Make sure you are on
that build or later by checking “About ImagePrint” from the ImagePrint Help menu (or checking for updates from
the HELP menu).

If you are on build 11.0.19 or later and PNG files still do not open, it may be that the ImagePrint configuration
files need to be updated. To do this:

- Launch the “IP Diagnostic” utility from your ImagePrint folder located in c: \ program files (x86)
- In the IP Diagnostic window, click APPLY beside “Troubleshoot Common Issues”.

You should see an option to Add PNG Support in the window that appears. Click APPLY beside that option and
PNG files should be able to be opened after restarting ImagePrint.

TIFF files won’t open (or open very slowly)

* Make sure to check the general question regarding File Names earlier in this document--nothing but letters,
spaces, underlines, hyphens and periods should be in the file name.

* LAYERS: ImagePrint can not guarantee support for Photoshop layers. Many layers work fine, but if you have
problems opening or printing tiff files, the first thing to do is flatten the image to remove any layers.

* The Pixel Order can also cause images not to open, or to open and display incorrectly or to open and print
very slowly. In Photoshop’s “Save As...” dialog, in the TIFF options section, make sure the Pixel Order is
always INTERLEAVED, never “Per Channel”.

» Alpha Channels: ImagePrint does not support non-color channels in TIFF files. Make sure that no extra
channels are present in your image. To check for extra channels, open the file in Photoshop. Choose
CHANNELS under the Photoshop Windows menu. In the Channels palette that appears, you should only see
the standard color channels (i.e., R,G,B for an RGB image). Delete any extra channels and save a copy of
your image for printing.

PSD (Photoshop) files won’t open (or print slowly)

» Make sure to check the general question regarding File Names earlier in this document--nothing but letters,
spaces, underlines, hyphens and periods should be in the file name

* In many cases, problems opening Photoshop files can be resolved by flattening the image in Photoshop prior
to opening it in ImagePrint. While layers often are fine, there are some layers that can cause problems--this is
especially true of “vector” type layers, like clipping paths or live text.

» Also, make sure that no extra (non-color) channels exist in the image. To check for extra channels, open
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the file in Photoshop. Choose CHANNELS under the Photoshop Windows menu. In the Channels palette that
appears, you should only see the standard color channels (i.e., R,G,B for an RGB image). Delete any extra
channels and save a copy of your image for printing.

» Try saving the file as a TIFF, or JPEG to avoid any issues with the Photoshop image format (which can some-
times have Photoshop specific information that doesn’t work well with non-Adobe applications)

The Profile Valet doesn’t show any profiles! (ImagePrint BLACK only)

1. The Profile Valet does not work with some older printers due to changes in the way the profiles are indexed.
The Epson 9600, 7600, 4000 and 2200 (and older) printers do not work with the Profile Valet. For those printers,
the Choose by Profiles option can be used instead, and new profiles can be downloaded via the Profile Manager
(described in chapter 6 of the ImagePrint Users Manual).

2. If you are on a supported printer and the Profile Valet shows no profiles, the profile index files may be corrupt.
Delete the indexes and relaunch ImagePrint as follows:

Click your Windows START menu and choose the ColorByte Software program group.
In the ColorByte Software program group, choose “Data Folder”.

In the folder window that appears, find the folder called “pindices”

Delete the entire pindices folder.

Relaunch ImagePrint and try the Profile Valet again.

3. Check in ImagePrint's PREFERENCES window (accessed via the VIEW menu within ImagePrint) that, in the
General Section, “Set Profile Valet Offline” is NOT checked.

4. If none of the above solutions help, it is very likely that ImagePrint’'s access to our Profile site is being blocked.

The Profile Valet uses FTP (not HTTP (web)) protocol, which some routers or firewalls may restrict or block. Check
your router/firewall settings for any restrictions on “Passive FTP” protocol.

If using a VPN (virtual private network) you may also experience problems accessing the Profile FTP site.

As a test, you can try accessing the site via an FTP program like WSFtp or CuteFTP. The ftp host address is:
ftp.colorbytesoftware.com
and both the username and password are: profiles

If that also fails to connect (or the connection is intermittant) then it is probable that fip communication is being
blocked on your computer or network. (Note that connecting to the site may be possible, but some routers/firewalls
severely slow down downloading files or make the connection erratic and prone to closing.)

If you can’t open access via your router or firewall, a workaround to a network that blocks access to our site might
be to temporarily tether or “hot spot” your computer’s wifi to your phone to use the phone’s internet connection,
thus avoiding your local network, when downloading profiles.
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The Image Strip doesn’t work correctly

1. If the Image Strip appears, but shows no files or folders, check that you have chosen a folder that actually contains
supported image files in the IMAGE STRIP FOLDER LOCATION section at the top of the Dashboard. (ImagePrint
supports jpeg, tiff, pdf and Photoshop psd files).

Remember--the Image Strip, while convenient, is not the only way to open files. You can also drag files directly
from their Windows folder into the Imageprint layout area, or use the standard
File -> Open menu dialog.

Also, in most cases, Adobe Bridge can be used with ImagePrint.

2. If you don’t see the Image Strip window at all, make sure that under the View menu within ImagePrint the Image
Strip is set to VISIBLE. If that still doesn’t make it appear, try choosing “Reset Window Positions” from the VIEW
menu to return the Image Strip (and other ImagePrint windows) to its default location.

Deleting the ImagePrint Registry Settings

ImagePrint maintains many of its settings in the Windows Registry. If these settings become corrupt, problems
may result, including issues with the File Browser, or settings windows that no longer appear on screen. In these
cases, deleting the ImagePrint registry entry may solve the problem. The registry entry will be rebuilt the next time
ImagePrint is launched with default settings in place.

Follow one of the below procedures to delete the ImagePrint registry settings.

NOTE: Any custom page sizes you have created will be lost as a result of deleting the ImagePrint Registry settings and
will need to be recreated via the User Defined page size window within ImagePrint. Also, your current Color Management
selections will be returned to their default state, so you will need to re-select your profiles and settings within the Color
Management window after deleting the registry entry. (You may want to record those Color Management settings before
proceeding so you can easily re-select them afterwards).

IMPORTANT: Make sure to close ImagePrint and Spoolface before removing the Registry entry.
Method 1 (preferred) - Deleting the ImagePrint registry entry via the ImagePrint Diagnostic Utility

* Launch the IP Diagnostic Utility by double-clicking the “IP Diagnostic.exe” file in its location within the ImagePrint
folder (c:\program files(x86)\imageprint)

* In the Diagnostic Utility, click the Apply button beside “Troubleshoot Common Problems”
* In the Window that appears, click Apply next to the entry: “Delete ImagePrint Registry Key”.
» Close the Diagnostic Utility when it reports that the procedure is complete

» Launch ImagePrint to see if the problem has been corrected.
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Method 2 - Manually deleting the ImagePrint registry entry via RegEdit
Only use this method if the Method 1 reports a problem or IP Diagnostics .exe is unavailable

The Windows registry contains vital Windows system settings. Failure to follow these instructions care-
fully could result in problems with your Operating System.

* Launch the Windows Regedit utility:

Type regedit in the Windows Search field, and double-click Regedit.exe when it appears in the
results listing.

* When the Regedit window appears double-click the HKEY_CURRENT_USER folder in the list of folders
appearing on the left side to expand the list. Double click the Software folder icon, then the ColorByte
Software folder icon.

* Right-click the ImagePrint 11.0 folder icon and choose DELETE. That will delete our registry entry (it will
be rebuilt when Imageprint restarts).

* Restart ImagePrint and check if the problem is resolved.
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Problems and questions related to printing and printing errors with ImagePrint BLACK are listed in this section
The Nothing Prints! Checklist

There could be many reasons for your jobs not to make it to the printer. Here are the things to check when
you are unsure of the problem. Carefully stepping through this list should solve the vast majority of printing
issues with ImagePrint Black.

Note: Many of these items require you to have launched SpoolFace (the ImagePrint print spooler) by
choosing it from ImagePrint FILE menu or via the printer icon in the top right of the ImagePrint Dashboard.
Spoolface shows the status of your printing and any error messages that occur.

* No Dongle or No License? DEMO printing occurs when ImagePrint is running in “DEMO” mode due to
the USB dongle not being available or a proper printer license not being in place. You will get either get
no output from the printer if a license issue is detected and you are set to “Do not print in Demo” mode in
Spoolface under the Queue menu, or, if “Do Print in Demo” is selected in the menu you will get a DEMO
watermark on your output. Check the status area on the right side of the spoolface window to see if an
encryption/licensing issue is reported. Usually License and Dongle related messages are reported in RED.
The most recent messages will be listed lowest in the status area. If you see license or dongle related
errors, see the earlier section of this document (Licensing Issues) for trouble-shooting tips.

What'’s the code? If there is an error when SpoolFace processes the print job, a status with a numeric
code will appear in the VERY bottom left corner of the SpoolFace window. It will be in the form: Job ##
Finished with error ###. This code can be very helpful in determining the cause of the problem. A list of the
most common numeric error codes that may appear in SpoolFace appears later in this guide: Spoolface
Error Codes If you do not see that status area, the bottom of the screen may be blocking it--try dragging
the spoolface window up a bit. There will ALWAYS be some status shown in the bottom left corner of the
spoolface window, even if just “Printer Idle”, so if you don’t see the status area keep looking--it's there.

* Paused? Click the Queue menu at the top of the SpoolFace window and make sure that printing is not
paused. The spooler will pause all jobs if it encounters an error (such as running out of ink or paper) and
it is important that you un-pause the spooler after correcting the problem or nothing new will be sent to the
printer. If the queue is paused there will be a check mark next to the word PAUSE under the Queue menu
at the top of the Spoolface window, and the status message in the bottom left corner of spoolface will say
“Paused” along with the last error code (if any). Unpause the queue by simply selecting the PAUSE entry
under the QUEUE menu (Be careful! Once you un-pause the queue, any jobs at the top of SpoolFace will
be in line to print--clear out any jobs you don’t want from the top by dragging them down to the SAVED
part of SpoolFace).

+ Old Job(s) in the way? The top job in the top (active) section of Spoolface is only job currently attempting
to print. If that top job had or has a problem no other jobs under it will be able to print until that job is can-
celled (usually by dragging it down to the SAVED side of spoolface, or, if that doesn’t work, choosing Force
Quit Current Job from Spoolface’s Queue menu.

* Wrong setting in ImagePrint? Sometimes printing problems are the result of an incorrect setting within
ImagePrint. Actually--not many wrong settings can stop printing cold, but NOT having chosen a profile for
your media can. So--make very sure you have chosen and APPLIED a Printer profile for your media in the
Profile Section of the Dashboard. The currently applied printer profile will always show in Blue beside the
word Printer Profile in the Dashboard--if you don’t see your profile in blue there it is not applied. With no
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paper profile applied printing will fail, often with an error 768 or 513 in Spoolface.

Nothing appears in Spoolface? If nothing prints AND you're getting no job added to the top (Active)
part of spoolface when you click PRINT in ImagePrint, check the following section: Nothing appears in
SpoolFace (and nothing prints!)

Print to File? Make sure the Print to File option is not selected in the Dashboard->Advanced->Print Setup
section of ImagePrint. With Print to File enabled, no printing will take place--instead a TIFF file containing
the layout will be created.

Do Not Print mode enabled? In Spoolface, under the QUEUE menu, there’s a Do Not Print At All choice
in the DEMO BEHAVIOR section. Make sure that’s not enabled or no jobs will print at all.

Error on the Printer? If prints are failing and you’re getting an error on the printer, see the entry later in
this section Common Printer Error Messages.

Nothing Obvious? If nothing above helped you to pinpoint the problem, there’s a good chance the prob-
lem is either 1.) A driver/connectivity problem or 2.) A Windows permissions problem.

Fixing Permissions problems: A Permissions problem can be a little hard to diagnose. Generally,
printing fails with no error, or possibly you’ll see some License related errors in SpoolFace even though
IPSetup shows your printer as licensed. This problem can seem to happen out of the blue, though usu-
ally it’s after a Windows update.

The good news is that the IP Diagnostic utility in your ImagePrint folder can quickly fix permissions
related problems. If you're having a problem printing with no obvious cause on Windows, try following
the procedure outline here: Opening Permissions with the IP Diagnostic Ultility.

Fixing Printer and Driver Communication Problems: The final common printing issue involves
problems communicating with the printer. Problems there can result in print jobs hanging at the top of
spoolface with 0% printed or jobs that move down to the Saved side of SpoolFace quickly with no error
at all (and no printing.)

ImagePrint has several ways of communicating with printers, depending on your printer model, so
solutions to this problem depend on which printer you are using. For some newer model printers
ImagePrint utilizes the Windows System printer driver to send our processed and color managed data
to the printer. For other printers we communicate directly via USB or your network (Wifi or Ethernet).

Please go to the below section that corresponds to your printer and connection type for suggestions on
fixing communication problems:

System Printer Driver Printers that utilize the Windows System Driver to communicate with the
printer include the Epson P5000, P6000, P7000, P8000, P9000, P10000 and P20000 and the
Canon Pro 1000, 2000, 4000 and 6000. If you have one of these printers, go to: Windows System
Driver - Connectivity and Communication Issues later in this document.

Direct Printing All other printers bypass the system driver and print directly via USB or Network.
For printer communication issues involving these printers, go to this section: Direct Printing -
Connectivity and Communication Issues.
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Direct Printing (USB or NETWORK) - Connectivity and Communication Issues

These suggestions apply only if your printer does NOT use the System Printer Driver for its communication
with ImagePrint as specified when installing in IPSetup. Printers in this category include the Epson 2200,
2400, 2880, P600, 3800, 3880, 4000, 4800, 4880, 4900, P800, 7600, 7800, 7880, 7900, 9600, 800, 9880,
9900 and 11880.

Wrong connection? A common cause of printing problems is an incorrect Printer connection (i.e., USB or
Ethernet) having been specified in IPSetup when ImagePrint was originally installed. If you suspect this is a
problem, reinstall the printer following the basic setup instructions earlier in this guide in the entry entitled:
Reinstalling your ImagePrint Driver

Printer Network (IP) Address Problem? If your printer is connected via Ethernet or WIFI a common
reason for prints to fail or “hang” at the top of SpoolFace is an incorrect IP Address listed for the printer in
ImagePrint’s IPSetup utility. This can happen out of the blue when the printer’s IP Address changes (like
after a factory reset, or if it was set to AUTO instead of Manual for the IP Address configuration mode).
When this happens, ImagePrint is looking for the printer on one IP Address, but the printer is now on
another.

For information on checking and/or changing the printer’s IP Address, check the entry in this guide entitled:
Networked printer settings. Once you know the current IP Address of the printer, double-check that

the same IP Address was used in IPSetup (launch IPSetup from the ColorByte Software group in your
Windows Start Menu and check the IP Address shown in the printer’s listing (it will be 4 numbers in the
form ### ### A ### with a “/9100” after it). If the IP Address shown in IPSetup is not the currently cor-
rect IP Address for the printer, reinstall the printer using the instructions at the beginning of this guide
entitled: Reinstalling your ImagePrint Driver. (Note: The printer may show zeros in the beginning some
of the numbers listed in the IP Address, but they do not matter--010 is the exact same as 10.)

Jobs print, but move down to the SAVED side of SpoolFace before printing starts? The Windows
system driver for your printer can sometimes intercept jobs going to the port it is using. In this scenario,
jobs sent from ImagePrint are put into the Windows spooler and no longer monitored by Spoolface. Jobs
should always stay on the active (top) side of the spoolface window until just before the printer is done with
them.

When this happens, jobs will move down quickly before printing and may fail to print completely. You can
check for this condition by right clicking the driver for your printer in Window’s Devices and Printers list,
and choosing PRINTER PROPERTIES (not just properties) in the menu that appears. In the Advanced
section of Printer Properties window, make sure it is set to Print Directly to Printer. (Note: Be sure to
check the manufacturer’s system driver for your printer--NOT the ImagePrint (PTA) driver that may
also exist in Devices and Printers.)
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Windows System Driver - Connectivity and Communication Issues

These suggestions apply only to the Epson P5000, P6000, P7000, 7890, P8000, P9000, 9890, P10000 or P20000 or
the Canon Pro 1000, 2000, 4000 or 6000. These printers use the Windows System Printer driver for their communica-
tion.

Check the System Printer Queue Go to your Windows Devices and Printers control panel and double-click the
driver for your printer to access its job queue. If there are jobs listed, try deleting them then try printing again. (Note
that any errors listed in this window may indicate a printer issue that needs to be corrected according to the printer
manufacturer’s instructions.)

Try printing from another application Try printing to the printer from another application to be sure there’s no
problem with the system printer driver. If other applications can’t print as well, you may need to reinstall the printer
driver according to your printer manufacturer’s instructions (typically you would remove the driver from the Windows
Devices and Printers control panel, then go to the printer maker’s web site, download the driver and reinstall it).
After reinstalling the printer driver, make sure to remove/re-add the printer in IPSetup according to the instructions
earlier in this guide: Re-installing your ImagePrint printer driver.

A Quick Note on settings within the System Printer Driver
ImagePrint Black overrides all of the settings in the System Driver when it sends its jobs. It just uses the driver as a con-
duit to the printer. So, there’s no need to worry about the current settings in the driver--and it does not have to be set to
the default printer in order for ImagePrint to use it.

US version of Driver? ImagePrint Black requires the United States version of the printer manufacturer’s driver be
used (even if you aren’t in the US). If you have installed a non-US version, remove it via Windows Devices and
Printers control panel, then go to the US web site for your printer manufacturer and download and install the US
version.

For Canon printers, the US site is: www.usa.canon.com
For Epson printers, the US site is: epson.com/usa

After reinstalling the printer driver, make sure to remove/re-add the printer in IPSetup according to the instructions
earlier in this guide: Re-installing your ImagePrint printer driver.

Media Type not available on Printer or System Driver (Canon Printers Only) Canon printers require that
the Media Type used in a print job exists on both the printer and the system printer driver. (The Media Type is the
media configuration pre-set that tells the printer the proper paper feed and ink settings for a given media).

When printing from ImagePrint Black, the best Media Type for the paper is automatically sent with the job. Although
we only pick standard Media Types that normally exist on the printer, there can be times when that Media Type has
been removed, in which case the job may disappear from the Canon driver’s queue without ever printing.

The fix is to update the printer and system driver with the proper Media Types. Follow the procedure later in this
guide: Updating CANON printers and system drivers with the Media Configuration Tool, then try printing again.

XPS Driver not installed (Canon Printers Only) On Windows, the XPS version of the Canon driver must be
installed. If you have installed the non-XPS version, remove it and download and install the XPS version for your
printer from the Canon website. Once you have installed the correct driver, remove and re-add the ImagePrint print-
er in IPSetup according to the instructions earlier in this guide: Re-installing your ImagePrint printer driver.

Reinstall the Driver When all else fails, try removing and reinstalling the system printer driver. First, remove the
driver from the Devices and Printers control panel. Then, download the driver again from your printer maker’'s USA
website and install it.

For Canon printers, the US site is: www.usa.canon.com
For Epson printers, the US site is: epson.com/usa

After reinstalling the printer driver, make sure to remove/re-add the printer in IPSetup according to the instructions
earlier in this guide: Re-installing your ImagePrint printer driver.
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Updating CANON printers and system drivers with the Media Configuration Tool

If a print job specifies a common Media Type that’s not available on your Canon printer or system driver the job
may fail to print or print incorrectly. In order to ensure you have the standard Media Types available on both the
printer and system printer driver, use the Canon Media Configuration Tool.

That'’s the utility Canon provides to sync the Media Types available on your printer with those on the computer.
You may already have it installed (it's shipped with the printer software) but if not, you can download it from the
www.usa.canon.com web site, or use one of the below links:

Canon Pro 6000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-6000?subtab=downloads-software

Canon Pro 4000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-4000?subtab=downloads-software

Canon Pro 2000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-2000?subtab=downloads-software

Canon Pro 1000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-1000?subtab=downloads-software

Once it's downloaded, double-click the utility to run it—it will locate your Canon printer and sure all your media
types are up to date. (This process usually takes about 3 minutes). When it’s finished, you will need to update
the Canon system printer driver with the media types by following the below procedure:

Windows

Open your Devices control panel (on most versions of windows, you can just click the start menu and type
“Devices” and it should show in the list).

Click on the Canon Pro-2000 XPS or Canon Pro-4000 XPS, and then click “Manage”, then click on “Printer
Properties”.

Once the Printer Properties window opens, choose “Device Settings” and click on the “Update Media
Information” button.

Macintosh

Choose System Preferences from your Mac’s Apple Menu, then Printers & Scanners. Click on the Canon

Pro printer in the list of printers, then click on “Options and Supplies”. In the Options and Supplies window,
click the UTILITY Tab along the top. Choose “Open Printer Utility”. Click “Media Info” then click UPDATE.

That'’s it—it will make sure what’s on your printer is in sync with what’s on the computer.
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Nothing appears in SpoolFace (and nothing prints!)

1.) Are you sure that nothing appears in SpoolFace? Sometimes it may seem like no job went into
SpoolFace, but in fact it just moved to the Saved (bottom) very quickly. If the job is actually hitting the
top (active) side and then moving to the bottom quickly, there may be some error status (like a Licensing/
Dongle issue) on the right side of spoolface that sheds light on what’s happening. If there’s defi-
nitely no errors there and the job is moving down without printing, check the Fixing Printer and Driver
Communication Problems entry earlier in this document.

2.) Wrong Printer? If you have multiple ImagePrint printers installed, make sure you have the right one
selected under the PRINTERS menu in Spoolface. Only jobs from the selected printer will show.

3.) OS Update? ImagePrint libraries may have been overwritten in a recent Operating System update. To fix
that, try checking for updates from ImagePrint’'s Help menu. Applying the latest update--even if you are
already using it--can fix a lot of problems due to OS updates (This is most especially true on Macintosh
computers).

4.) Anti-virus software? It's not uncommon for anti-virus software to block, delete or quarantine parts of
ImagePrint. Even if you've had no problem, an update can cause an anti-virus program to suddenly mis-
identify an ImagePrint component as suspicious and block, quarantine or even delete it.

Try disabling any anti-virus software as a test--Note: because disabling often leaves anti-virus com-
ponents still running, you may need to uninstall the anti-virus software as a test to ensure it is still not
blocking the printing processes.

Repair the Damage: If you suspect your anti-virus has deleted or quarantined some component of
ImagePrint, you can try a repair (After disabling the anti-virus software!) via the Programs and Apps
control panel on your Windows system. In that Control Panel, double-click ImagePrint Black/RED
and choose REPAIR when given the option. That will put back many ImagePrint components and
may fix the problem.

Make an Exclusion: Most Anti-virus software programs let you designate folders and programs to be
excluded from virus scanning. If yours does, you should tell the anti-virus software not to scan these
folders and their sub-folders to prevent future problems:

\ program files (x86) \ ImagePrint
and

\ programdata \ ColorByte Software \ ImagePrint
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Common Printer Error Messages
The below messages may appear on the front panel of your printer when a print job fails
“Load ROLL” (or Sheet) Paper

This message appearing on the printer means that ImagePrint Black is set to a paper type (sheet
or roll) that is not currently loaded in the printer. Make sure the correct setting is in place in the
ImagePrint Dashboard in the Media Feed section. Once you have set the Media Feed correctly,
cancel any old failed jobs in spoolface by dragging them down to the SAVED section, unpause the
QUEUE via the QUEUE menu at the top of the Spoolface window and make sure the printer is back
to a Ready before trying a new print.

In addition to the above, for some printers you will need to make sure the printer’s control panel (on
the front of the printer) is set to the right mode for the currently loaded paper type. (Often, pressing
the Roll/Sheet button on the printer when this error occurs will let the job continue).

“Forbidden Media”

This message, on the front console of the printer occurs when the printer rejects paper as illegal to
load in the paper tray. Only certain papers are certified to work with the printer tray. If you wish to
have the printer use the loaded paper anyway, you can choose another paper as the “Media Type”
by clicking Options within the Dashboard’s ADVANCED->Print Setup section. Media Types control
the paper feed controls of the printer--pick one as close as possible to the thickness of the paper in
the paper tray to avoid banding issues.

IMPORTANT: Changing the media type from the default in this way may adversely affect print quality
for printers that also use the media type setting to specify inking characteristics. Newer printers such
as the Canon 1000, 2000, 4000 and 6000, and the Epson P5000, 6000, 7000, 8000, 9000, 10000
and 20000 use the media type setting to set inking characteristics.

“Reload Paper”/”’Paper Out”

“Reload Paper messages often mean the paper loaded in the printer is NARROWER than the page
size specified in ImagePrint. You can correct this by specifying a smaller page size in ImagePrint, or,
by disabling the “Check Sheet Size” option in the Printer’s front control panel. In some cases, manu-
facturers ship paper that is incorrectly sized, so make sure to measure your paper to ensure it is the
size stated on its packaging--even small differences in size can cause this error to occur.

“Paper Out” messages, or the paper feeding through the printer without printing, typically occurs if
the paper in the printer is SHORTER than the page size specified in ImagePrint. To correct, specify
a page size in ImagePrint that is the same as the physical paper’s length or shorter. (Double check
by measuring the actual paper--some manufacturers can be slightly inaccurate in the dimensions
specified on the box).

Another cause of paper feeding right through the printer without printing is a paper sensor issue.
Make sure to use a clean sheet of paper, as the printer’s sensors check for paper white and can be
fooled by previously printed images on a page.

Back to Table of
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“Wrong Page Size”

If the message “Wrong Page Size” appears on an Epson printer when attempting to print, it is due to
the printer sensing a different page size than that being specified by ImagePrint. Printers can be very
sensitive to slight differences in page size, especially when loading thicker paper types. In some cases,
manufacturers ship paper that is incorrectly sized, so make sure to measure your paper to ensure it is
the size stated on its packaging--even small differences in size can cause this error to occur.

One way to avoid that error is to turn off the “Page Size Checking” feature of the printer. This will

cause the printer to no longer check the page size when printing. To turn page size checking off, on

the Epson’s front control panel, use the Menu button to enter the Printer Setup section. Use the up and
down keys to find the “Page Size Chk” entry. Hit the right arrow button to access that setting, then use
the UP arrow to toggle to OFF and hit the Enter key. An asterisk will appear next to the word OFF show-
ing it is now in effect. Then use the right arrow button repeatedly to get back to “Ready”. NOTE: Turning
off he “Page Size Chk” setting may cause prints to not be centered correctly when sheet paper is loaded
manually on the printer. (Often, pressing the Roll/Sheet button on the printer when this error occurs will
let the job continue)

Common Errors when launching Spoolface
Check the below suggestions when SpoolFace fails to launch or generates an error when launched
SpoolFace generates a “CONNECT” type error or crashes when launched

If you get an error with “Connect” in the error text--or an immediate crash when launching SpoolFace, a criti-
cal background process (MUXD.EXE) is probably not running. During ImagePrint’s installation, MUXD.EXE is
set to automatically launch each times Windows starts, but Anti-virus programs sometimes prevent the auto-
matic launch from happening or even delete the muxd.exe file entirely. It is beyond the scope of this manual
to provide support for the myriad anti-virus products available, but check your anti-virus logs to see if there’s
a report of muxd.exe being blocked. The Windows Firewall can also block muxd.exe, so check its settings as
well. You may need to set an “exclusion” for the \program files (x86)\ImagePrint folder within your antivirus
software settings to prevent the software from interfering with ImagePrint.

Note: Even if your anti-virus software has worked with ImagePrint in the past, it doesn’t mean it can’t change
with no warning. Antivirus software often update their virus definitions which can cause it to suddenly mis-
identify muxd.exe (or another ImagePrint component) as suspicious.

You can manually launch muxd.exe from it’s location within the ImagePrint/spool/mux folder. Just go to
c: \ program files (x86) \ ImagePrint \ Spool \ Mux

and double-click muxd.exe. A brief window will flash as the process is put into the background, but nothing
else will seem to happen. At that point, Spoolface should work... at least until you reboot windows.

MUXD.EXE not found?

If muxd.exe is NOT in the Mux folder, it has likely been deleted or quarantined by your anti-virus software! To get it
back, you can “Repair” ImagePrint by going to your Windows Control Panel, choosing Apps and Features (Windows
10) or Programs and Features (Windows 7/8) and double-clicking the ImagePrint RED/Black entry. Choose Repair
when prompted, and ImagePrint application files, including muxd.exe, should be replaced. Of course, there’s nothing

to prevent your anti-virus from removing it in the future, so make sure to check your particular anti-virus software’s
logs and settings to ensure it does not block, delete or quarantine muxd.exe (or any other ImagePrint process in the

future).
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Using the IP Diagnostic Utility to configure MUXD for auto-launch If, after doing the above manual
launch of MUXD.EXE the problem is solved--but... after rebooting your computer spoolface can not launch
properly again, chances are your firewall or antivirus software is stopping MUXD from automatically
launching at boot time. You can manually launch it again per the above steps--or track down what anti-
virus software on your system is blocking it (or firewall) and configure it to allow MUXD to auto-launch.
But--if you can’t determine the culprit, the IP Diagnostic utility can be used to launch MUXD and config-
ure it to launch automatically via your Windows Start-up folder rather than via the Registry. This different
method may allow MUXD to launch with interference in the future.

To try it: Launch the IP Diagnostic utility by double-clicking it within your ImagePrint folder (c: \ program
files (x86) \ ImagePrint \ IP Diagnostic.exe). Click Apply beside the “Trouble-shoot common prob-
lems” entry, then click Apply beside the “Set muxd to autostart” entry. Close the IP Diagnostic utility and
reboot your computer. If you can still launch Spoolface after rebooting, it worked!

“No Printers Found” error when launching SpoolFace

You may see a “No Printers found” message if you are on an ImagePrint CLIENT computer and are
launching SpoolFace for the first time. This is normal behavior as SpoolFace defaults to look for a printer
on the local computer instead of a networked HOST computer. To correct the problem, just choose
COMPUTER (from the SpoolFace menu), and pick the IP Address (or computer name) of the ImagePrint
HOST computer.

If there is no PRINTER or COMPUTER menu at the top of the screen when SpoolFace is active, there
is a problem with the installation. Close SpoolFace and ImagePrint, then re-launch IPSetup (from the
ImagePrint folder), remove and reinstall the printer(s) according the instructions in the beginning of this
document: Re-installing your ImagePrint printer driver. Be aware that removing printers will delete all old
print jobs for that printer!

“Bad Heartbeat” message in SpoolFace

Computer name change: This error indicates that ImagePrint is not able to communicate with its spooler.
The most common cause is a change in the name of the computer since the printer was installed via

IP Setup. If you have changed your computer name, it is necessary to run IP SETUP again to remove,
then reinstall, the printer (the new computer name will automatically be used for the new installation).
Important: Make sure that ImagePrint and Spoolface are not running when reinstalling your printers via IP
Setup.

Host/Client printing: This error can also occur when printing from an ImagePrint CLIENT to an
ImagePrint HOST computer if the two computers can not see each via the TCP/IP network protocol.
Firewalls or anti-virus software may also prevent the Client from communicating with the Host. You should
also check via the Windows Task Manager that the “muxd.exe” process is running on both the Host or
Client (muxd is necessary for client/host printing to take place). Check the section: Problems printing
from a networked client for information on troubleshooting problems in this area.
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Unknown TAG (or other Warnings) in the STATUS (right) section of SpoolFace

Warnings such as UNKNOWN TAG are not important and can be ignored. These are informational displays
only about things that do not affect printing. Almost all TIFF files will report “Unknown TAG warnings”
that can be ignored.

Extra print jobs sent to SpoolFace

This is the result of additional pages existing in the ImagePrint layout window. This can happen if AutoFlow
is enabled and you have added images to your layout without first deleting previous images via the scissors
tool--new pages are generated for new images when there is no room on the current page. By default, ALL
images on ALL pages will print when PRINT is selected.

Autoflow can be turned on and off via the AutoFlow checkbox in the Dashboard’s ADVANCED->Auto Layout
Settings section.

To delete ALL images from all pages, click the Red scissors icon in the Floating toolbar.

Couldn’t Set Up Watch folder error message in SpoolFace

If printing from a networked CLIENT computer, this message typically means the PRINTER NAME used when
installing ImagePrint on the CLIENT doesn’t exactly match the PRINTER NAME used when installing on the
host. Launch IP Setup from your ImagePrint folder on the CLIENT and make sure the installed printer match-
es that shown on the HOST. If not, remove and reinstall the printer on the client with the correct name.

If you are NOT on a remote Client and you see the “Couldn’t Set Up Watch” folder error, that typically means
your printer spool folder structure is corrupt. possibly due to a failed printer installation that couldn’t write files
to your hard drive because it did not have permissions, or pre-existing files it needed to overwrite were busy
when IP Setup was run Usually, removing and reinstalling the printer via IPSETUP will correct this problem
(you will lose your old spooled jobs however when removing the printer).
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Problems when printing from a networked client

A Client installation of Imageprint will run the normal ImagePrint interface, but, when Print is selected, will
send all of its jobs to the ImagePrint HOST computer (the Host is always the computer with the DONGLE
attached). When installing a client, remember that the Client does not need to be licensed in IPSetup. All
licensing is handled by the HOST at print time, so only the HOST computer needs to be licensed.

Below are things to check if you experiencing problems printing from a client to a host:

1.

2.

Make sure that the Host computer can print directly to the printer first to rule out a problem with
printing in general.

Make sure that the Client computer can access the Host across the network via normal Windows
networking.

Firewall settings, on either the Host or Client, can block ImagePrint from sending jobs. Try print-
ing from the Client with the Firewall disabled on both systems. Also, security software like Zone

Alarm, or anti-virus software, may be blocking the TCP/IP port that ImagePrint uses for network

communication. (ImagePrint uses port 1 for it’s client/host printing).

If the Host can print fine locally, but jobs from the Client do not appear in the Host’s SpoolFace
window, make sure that you correctly specified the name of the Host computer (or the IP Address
if the Host is a Macintosh) when installing ImagePrint on the Client. To double-check, launch
IPSetup and see what setting is listed in the COMPUTER column for the printer. If it does not show
the proper computer (or its IP Address), delete the printer using the DELETE PRINTER button in
IPSetup and then re-add the printer by clicking ADD PRINTER and following the prompts to add a
new client (remote) printer. Make very sure to pick “Remote Client” as the install type in the Printer
Parameters window and use the same printer name as used on the HOST computer. Also, make
sure to use the correct IP Address or name for the HOST computer when prompted to Specify the
Host Computer. (The HOST computer is the computer with the USB dongle attached).

Couldn’t set up Watch Folder: If you receive this error in SpoolFace it’s likely the PRINTER
NAME you specified when installing ImagePrint on the CLIENT does not exactly match the name
you used on the HOST. Re-add the printer via IPSetup making sure to use the exact same printer
name used on the host computer.

The process “muxd.exe” must be running on each Windows computer (host or client) in order for
communication to take place. You can confirm that this process is running via the Windows Task
Manager (hit Control-Alt-Delete to access it). If muxd.exe is NOT listed under “PROCESSES”
follow the procedures earlier in this guide to correct the problem: Spoolface crashes with a
“CONNECT” error.

T36

Back to Table of

Printing Problems - ImagePrint BLACK Troubleshooting
Contents




Troubleshooting - Printing Problems with ImagePrint BLACK Back to Table of
Contents

Job doesn’t move to the bottom (SAVED) side of SpoolFace when dragged down

Normally, dragging a job from the top (“Active”) pane to the bottom (“Saved”) pane should cancel it. If the job
will not move down (it pops back up), it means that the printing process is not being allowed to quit normally
by Windows. To force the job over, do one of the following:

1. Choose Force Quit Active Job from the Queue menu at the top of spoolface. That usually will kill
the job. Since it’'s always possible the printer received “some” data before the job hung, to ensure
you don’t get a patrtial print it’s a good idea to reboot the printer after force quitting a job. Also,
make sure to un-PAUSE the queue by unchecking the PAUSE entry under SpoolFace’s QUEUE
menu after force quitting.

2. If force quitting doesn’t work, PAUSE the queue by choosing Queue->Pause from the Spoolface
menu and then reboot the computer. The job should drag down with no problem when the system
comes back up. (It is important to pause the queue first to make sure the spooler doesn’t attempt
to print again as soon as the system reboots.) After rebooting and moving the job down, remem-
ber to re-enable the queue by choosing “Pause” from the same menu to get rid of the check mark
beside the Pause entry.

3. If Force Quitting didn’t work, and you don’t want to reboot the computer, you can use the Windows
Task Manager to kill the printing process. Access the Windows task manager by pressing Control-
Alt-Delete. Click TASK MANAGER, then PROCESSES. Choose either the printer driver execut-
able (i.e. epson10000.exe) or the process “ipbatch.exe” and click the “End Process” button. The
Jjob will immediately move over in spoolface. It's a good idea to reboot the printer after doing since
it may have gotten some partial print data in its memory that should be cleared.

Old computer names appear in my SpoolFace Computers menu

This can happen if you've installed ImagePrint as a Client to a HOST computer that’s no longer available on
your network. Reinstalling the printer to point to the new HOST computer may leave the old computer entries
in the COMPUTERS menu, which can be an annoyance.

To remove any old computer names from the Spoolface COMPUTERS menu, close spoolface and locate the
file “ip hosts” located in the Spool folder within the ImagePrint “data” folder (To get to the ImagePrint DATA
folder, choose “Data Folder” from the ColorByte Software Program Group in your Windows Start Menu.)

Edit the “ip_hosts” file using a standard text editor such as notepad and delete any lines containing unwanted
printers and resave the file, then relaunch Spoolface. (Make sure to leave no empty lines in the file including
at the very bottom). Save the file and restart SpoolFace and the invalid COMPUTER entries should be gone.
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Printing Problems - ImagePrint R.E.D.

Problems and questions related to printing and printing errors with ImagePrint R.E.D. are listed in this section
The Nothing Prints! Checklist

There could be many reasons for your jobs not to make it to the printer. Here are the things to check when
you are unsure of the problem. Carefully stepping through this list should solve the vast majority of printing
issues with ImagePrint R.E.D.

Note: Many of these items require you to have launched SpoolFace (the ImagePrint print spooler) by
choosing it from ImagePrint FILE menu or via the printer icon in the top right of the ImagePrint Dashboard.
Spoolface shows the status of your printing and any error messages that occur.

* No Dongle or No License? DEMO printing occurs when ImagePrint is running in “DEMO” mode due to
the USB dongle not being available or a proper printer license not being in place. You will get either get
no output from the printer if a license issue is detected and you are set to “Do not print in Demo” mode in
Spoolface under the Queue menu, or, if “Do Print in Demo” is selected in the menu you will get a DEMO
watermark on your output. Check the status area on the right side of the spoolface window to see if an
encryption/licensing issue is reported. Usually License and Dongle related messages are reported in RED.
The most recent messages will be listed lowest in the status area. If you see license or dongle related
errors, see the earlier section of this document (Licensing Issues) for trouble-shooting tips.

What'’s the code? If there is an error when SpoolFace processes the print job, a status with a numeric
code will appear in the VERY bottom left corner of the SpoolFace window. It will be in the form: Job ##
Finished with error ###. This code can be very helpful in determining the cause of the problem. A list of the
most common numeric error codes that may appear in SpoolFace appears later in this guide: Spoolface
Error Codes If you do not see that status area, the bottom of the screen may be blocking it--try dragging
the spoolface window up a bit. There will ALWAYS be some status shown in the bottom left corner of the
spoolface window, even if just “Printer Idle”, so if you don’t see the status area keep looking--it's there.

* Paused? Click the Queue menu at the top of the SpoolFace window and make sure that printing is not
paused. The spooler will pause all jobs if it encounters an error (such as running out of ink or paper) and
it is important that you un-pause the spooler after correcting the problem or nothing new will be sent to the
printer. If the queue is paused there will be a check mark next to the word PAUSE under the Queue menu
at the top of the Spoolface window, and the status message in the bottom left corner of spoolface will say
“Paused” along with the last error code (if any). Unpause the queue by simply selecting the PAUSE entry
under the QUEUE menu (Be careful! Once you un-pause the queue, any jobs at the top of SpoolFace will
be in line to print--clear out any jobs you don’t want from the top by dragging them down to the SAVED
part of SpoolFace).

+ Old Job(s) in the way? The top job in the top (active) section of Spoolface is only job currently attempting
to print. If that top job had or has a problem no other jobs under it will be able to print until that job is can-
celled (usually by dragging it down to the SAVED side of spoolface, or, if that doesn’t work, choosing Force
Quit Current Job from Spoolface’s Queue menu.

* Nothing appears in Spoolface? If nothing prints AND you’re getting no job added to the top (Active)
part of spoolface when you click PRINT in ImagePrint, check the following section: Nothing appears in
SpoolFace (and nothing prints!)

* Print to File? Make sure the Print to File option is not selected in the Dashboard->Advanced->Print Setup
section of ImagePrint. With Print to File enabled, no printing will take place--instead a TIFF file containing
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the layout will be created.

Do Not Print mode enabled? In Spoolface, under the QUEUE menu, there’s a Do Not Print At All choice in
the DEMO BEHAVIOR section. Make sure that’s not enabled or no jobs will print at all.

Error on the Printer? If prints are failing and you’re getting an error on the printer, see the entry later in this
section Common Printer Error Messages.

Permissions Problem? A Permissions problem can be a little hard to diagnose. Generally, printing fails with
no error, or possibly you’ll see some License related errors in SpoolFace even though IPSetup shows your
printer as licensed. This problem can seem to happen out of the blue, though usually it's after a Windows
update.

The good news is that the IP Diagnostic utility in your ImagePrint folder can quickly fix permissions related
problems. If you're having a problem printing with no obvious cause on Windows, try following the procedure
outline here: Opening Permissions with the IP Diagnostic Ultility.

System Printer Driver Problems: The final common printing issue involves problems with the Windows
Printer Driver for your printer. ImagePrint R.E.D. utilizes the driver supplied by your printer manufacturer to
communicate with the printer, and many settings--such as Page Size, Borderless behavior and Media Type are
taken from their driver. Any incorrect setting there--or any problem with the System Printer Driver itself--can
cause your prints to fail. Check the following section for suggestions on correcting issues due to the Windows
System Driver: Windows System Driver - Connectivity and Settings Issues.

Windows System Driver - Connectivity and Settings Issues

Check the System Driver Settings In ImagePrint R.E.D., click the Setup... button in the Printers section

of Dashboard to access your printer’'s Windows Driver. It's vital that you have correctly set the key elements:
page size, media type and color management (ICM) mode for your printer before printing. (In addition, settings
like borderless mode, auto-cut mode should be correctly configured although they are less likely to cause a
print to fail.)

The specifics on where and how to set the media type, page size and color management mode vary from
printer to printer, but generally the steps are close for the same make of printer. For a walkthrough on common
settings to use for Canon and Epson printers, see the Appendix of the ImagePrint R.E.D. Users Manual, which
is available via the Help menu within ImagePrint. It can also be accesses directly from your ImagePrint folder.
For a guide to setting up your printer driver, also see Chapter 4, The Basics, of the ImagePrint manual.

* Check the System Driver Queue |If jobs have failed to print with no obvious error, they may be “stuck” in the

system printer’s spooler. Go to your Windows Devices and Printers control panel and double-click the driver
for your printer to access its job queue. If there are jobs listed, try deleting them then try printing again. (Note
that any errors listed in this window may indicate a printer issue that needs to be corrected according to the
printer manufacturer’s instructions.)

Try printing from another application Try printing to the printer from another application to be sure there’s
no problem with the system printer driver. If other applications can’t print as well, you may need to reinstall the
printer driver according to your printer manufacturer’s instructions (typically you would remove the driver from
the Windows Devices and Printers control panel, then go to the printer maker’s web site, download the driver
and reinstall it). After reinstalling the printer driver, make sure to reselect it in ImagePrint R.E.D. and check it's
settings by clicking the Setup... button in that section.

Media Type not available on Printer or System Driver (Canon Printers Only) Canon printers require that
the Media Type used in a print job exists on both the printer and the system printer driver. (The Media Type is
the media configuration pre-set that tells the printer the proper paper feed and ink settings for a given media).
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If you suspect that the media type you chose in the Windows Printer Driver is not available on the printer, the
fix is to update the printer and system driver with the proper Media Types. Follow the procedure later in this
guide: Updating CANON printers and system drivers with the Media Configuration Tool, then try printing again.

* Reinstall the Driver When all else fails, try removing and reinstalling the system printer driver. First, remove
the driver from the Devices and Printers control panel. Then, download the driver again from your printer mak-
er's USA website and install it.

For Canon printers, the US site is: www.usa.canon.com
For Epson printers, the US site is: epson.com/usa

After reinstalling the printer driver, make sure to reselect it in ImagePrint R.E.D. and check it’s settings by click-
ing the Setup... button in that section.

Updating CANON printers and system drivers with the Media Configuration Tool

If a print job specifies a common Media Type that’s not available on your Canon printer or system driver the job
may fail to print or print incorrectly. In order to ensure you have the standard Media Types available on both the
printer and system printer driver, use the Canon Media Configuration Tool.

That'’s the utility Canon provides to sync the Media Types available on your printer with those on the computer.
You may already have it installed (it's shipped with the printer software) but if not, you can download it from the
www.usa.canon.com web site, or use one of the below links:

Canon Pro 6000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-6000?subtab=downloads-software

Canon Pro 4000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-4000?subtab=downloads-software

Canon Pro 2000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-2000?subtab=downloads-software

Canon Pro 1000

https://www.usa.canon.com/internet/portal/us/home/support/details/professional-large-format-printers/pro-
fessional-photo-fine-art/imageprograf-pro-1000?subtab=downloads-software

Once it's downloaded, double-click the utility to run it—it will locate your Canon printer and sure all your media
types are up to date. (This process usually takes about 3 minutes). When it’s finished, you will need to update
the Canon system printer driver with the media types by following the below procedure:

Open your Devices control panel (on most versions of windows, you can just click the start menu and type
“Devices” and it should show in the list).

Click on the Canon Pro-2000 XPS or Canon Pro-4000 XPS, and then click “Manage”, then click on “Printer
Properties”.

Once the Printer Properties window opens, choose “Device Settings” and click on the “Update Media
Information” button.
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Nothing appears in SpoolFace (and nothing prints!)

1.) Are you sure that nothing appears in SpoolFace? Sometimes it may seem like no job went into SpoolFace,
but in fact it just moved to the Saved (bottom) very quickly. If the job is actually hitting the top (active) side and
then moving to the bottom quickly, there may be some error status (like a Licensing/Dongle issue) on the right side
of spoolface that sheds light on what’s happening. If there’s definitely no errors there and the job is moving down
without printing, check the Fixing Printer and Driver Communication Problems entry earlier in this document.

2.) Wrong Printer? If you have multiple ImagePrint printers installed, make sure you have the right one selected under
the PRINTERS menu in Spoolface. Only jobs from the selected printer will show.

3.) OS Update? ImagePrint libraries may have been overwritten in a recent Operating System update. To fix that, try
checking for updates from ImagePrint’s Help menu. Applying the latest update--even if you are already using it--can
fix a lot of problems due to OS updates (This is most especially true on Macintosh computers).

4.) Anti-virus software? It's not uncommon for anti-virus software to block, delete or quarantine parts of ImagePrint.
Even if you've had no problem, an update can cause an anti-virus program to suddenly misidentify an ImagePrint
component as suspicious and block, quarantine or even delete it.

Try disabling any anti-virus software as a test--Note: because disabling often leaves anti-virus components still
running, you may need to uninstall the anti-virus software as a test to ensure it is still not blocking the printing
processes.

Repair the Damage: If you suspect your anti-virus has deleted or quarantined some component of

ImagePrint, you can try a repair (After disabling the anti-virus software!) via the Programs and Apps con-
trol panel on your Windows system. in that Control Panel, double-click ImagePrint Black/RED and choose
REPAIR when given the option. That will put back many ImagePrint components and may fix the problem.

Make an Exclusion: Most Anti-virus software programs let you designate folders and programs to be exclud-
ed from virus scanning. If yours does, you should tell the anti-virus software not to scan these folders and
their sub-folders to prevent future problems:

\ program files (x86) \ ImagePrint
and

\ programdata \ ColorByte Software \ ImagePint
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Common Printer Error Messages
The below messages may appear on the front panel of your printer when a print job fails
“Load ROLL” (or Sheet) Paper

This message appearing on the printer means that ImagePrint Black is set to a paper type (sheet or roll)
that is not currently loaded in the printer. Make sure you have selected the right type in the Windows
Printer Driver. Before printing again, you should check the Windows Printer Driver’s queue (in Windows
Devices and Printers) and clear any failed jobs from it along with any error messages the driver may
show.

In addition to the above, for some printers you will need to make sure the printer’s control panel (on the
front of the printer) is set to the right mode for the currently loaded paper type. (Often, pressing the Roll/
Sheet button on the printer when this error occurs will let the job continue).

“Forbidden Media”

This message, on the front console of the printer occurs when the printer rejects paper as illegal to load
in the paper tray. Only certain papers are certified to work with the printer tray.

“Wrong Page Size”

If the message “Wrong Page Size” appears on an Epson printer when attempting to print, it is due to the

printer sensing a different page size than that being specified in the Windows Printer Driver for your print-
er. Printers can be very sensitive to slight differences in page size, especially when loading thicker paper
types. In some cases, manufacturers ship paper that is incorrectly sized, so make sure to measure your

paper to ensure it is the size stated on its packaging--even small differences in size can cause this error

to occur.

One way to avoid that error is to turn off the “Page Size Checking” feature of the printer. This will

cause the printer to no longer check the page size when printing. To turn page size checking off, on

the Epson’s front control panel, use the Menu button to enter the Printer Setup section. Use the up and
down keys to find the “Page Size Chk” entry. Hit the right arrow button to access that setting, then use
the UP arrow to toggle to OFF and hit the Enter key. An asterisk will appear next to the word OFF show-
ing it is now in effect. Then use the right arrow button repeatedly to get back to “Ready”. NOTE: Turning
off he “Page Size Chk” setting may cause prints to not be centered correctly when sheet paper is loaded
manually on the printer. (Often, pressing the Roll/Sheet button on the printer when this error occurs will
let the job continue)
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Common Errors when launching Spoolface

Check the below suggestions when SpoolFace fails to launch or generates an error when
launched

SpoolFace generates a “CONNECT” type error or crashes when launched

If you get an error with “Connect” in the error text--or an immediate crash when launching SpoolFace,

a critical background process (MUXD.EXE) is probably not running. During ImagePrint’s installation,
MUXD.EXE is set to automatically launch each times Windows starts, but Anti-virus programs sometimes
prevent the automatic launch from happening or even delete the muxd.exe file entirely. It is beyond the
scope of this manual to provide support for the myriad anti-virus products available, but check your anti-
virus logs to see if there’s a report of muxd.exe being blocked. The Windows Firewall can also block
muxd.exe, so check its settings as well. You may need to set an “exclusion” for the \program files (x86)\
ImagePrint folder within your antivirus software settings to prevent the software from interfering with
ImagePrint.

Note: Even if your anti-virus software has worked with ImagePrint in the past, it doesn’t mean it can'’t
change with no warning. Antivirus software often update their virus definitions which can cause it to sud-
denly misidentify muxd.exe (or another ImagePrint component) as suspicious.

You can manually launch muxd.exe from it's location within the ImagePrint/spool/mux folder. Just go to
c: \ program files (x86) \ ImagePrint \ Spool \ Mux

and double-click muxd.exe. A brief window will flash as the process is put into the background, but noth-
ing else will seem to happen. At that point, Spoolface should work... at least until you reboot windows.

MUXD.EXE not found?

If muxd.exe is NOT in the Mux folder, it has likely been deleted or quarantined by your anti-virus software!
To get it back, you can “Repair” ImagePrint by going to your Windows Control Panel, choosing Apps and
Features (Windows 10) or Programs and Features (Windows 7/8) and double-clicking the ImagePrint RED/
Black entry. Choose Repair when prompted, and ImagePrint application files, including muxd.exe, should be
replaced. Of course, there’s nothing to prevent your anti-virus from removing it in the future, so make sure to
check your particular anti-virus software’s logs and settings to ensure it does not block, delete or quarantine
muxd.exe (or any other ImagePrint process in the future).

Using the IP Diagnostic Utility to configure MUXD for auto-launch If, after doing the above manual
launch of MUXD.EXE the problem is solved--but... after rebooting your computer spoolface can not
launch properly again, chances are your firewall or antivirus software is stopping MUXD from automati-
cally launching at boot time. You can manually launch it again per the above steps--or track down what
anti-virus software on your system is blocking it (or firewall) and configure it to allow MUXD to auto-
launch. But--if you can’t determine the culprit, the IP Diagnostic utility can be used to launch MUXD
and configure it to launch automatically via your Windows Start-up folder rather than via the Registry.
This different method may allow MUXD to launch with interference in the future.

To try it: Launch the IP Diagnostic utility by double-clicking it within your ImagePrint folder (c: \ pro-
gram files (x86) \ ImagePrint \ IP Diagnostic.exe). Click Apply beside the “Trouble-shoot common
problems” entry, then click Apply beside the “Set muxd to autostart” entry. Close the IP Diagnostic
utility and reboot your computer. If you can still launch Spoolface after rebooting, it worked!
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“Bad Heartbeat” message in SpoolFace

Computer name change: This error indicates that ImagePrint is not able to communicate with its
spooler. The most common cause is a change in the name of the computer since the printer was
installed via IP Setup. If you have changed your computer name, it is necessary to run IP SETUP again
to remove, then reinstall, the printer (the new computer name will automatically be used for the new
installation). Important: Make sure that ImagePrint and Spoolface are not running when reinstalling your
printers via IP Setup.

Unknown TAG (or other Warnings) in the STATUS (right) section of SpoolFace

Warnings such as UNKNOWN TAG are not important and can be ignored. These are informational displays
only about things that do not affect printing. Almost all TIFF files will report “Unknown TAG warnings”
that can be ignored.

Extra print jobs sent to SpoolFace

This is the result of additional pages existing in the ImagePrint layout window. This can happen if AutoFlow
is enabled and you have added images to your layout without first deleting previous images via the scissors
tool--new pages are generated for new images when there is no room on the current page. By default, ALL
images on ALL pages will print when PRINT is selected.

Autoflow can be turned on and off via the AutoFlow checkbox in the Dashboard’s ADVANCED->Auto Layout
Settings section.

To delete ALL images from all pages, click the Red scissors icon in the Floating toolbar.

Job doesn’t move to the bottom (SAVED) side of SpoolFace when dragged down

Normally, dragging a job from the top (“Active”) pane to the bottom (“Saved”) pane should cancel it. If the job
will not move down (it pops back up), it means that the printing process is not being allowed to quit normally
by Windows. To force the job over, do one of the following:

1. Choose Force Quit Active Job from the Queue menu at the top of spoolface. That usually will kill
the job. Since it's always possible the printer received “some” data before the job hung, to ensure
you don’t get a partial print it’s a good idea to reboot the printer after force quitting a job. Also,
make sure to un-PAUSE the queue by unchecking the PAUSE entry under SpoolFace’s QUEUE
menu after force quitting.

2. If force quitting doesn’t work, PAUSE the queue by choosing Queue->Pause from the Spoolface
menu and then reboot the computer. The job should drag down with no problem when the system
comes back up. (It is important to pause the queue first to make sure the spooler doesn’t attempt
to print again as soon as the system reboots.) After rebooting and moving the job down, remem-
ber to re-enable the queue by choosing “Pause” from the same menu to get rid of the check mark
beside the Pause entry.

3. If Force Quitting didn’t work, and you don’t want to reboot the computer, you can use the Windows
Task Manager to kill the printing process. Access the Windows task manager by pressing Control-
Alt-Delete. Click TASK MANAGER, then PROCESSES. Choose either the printer driver execut-
able (i.e. epson10000.exe) or the process “ipbatch.exe” and click the “End Process” button. The
Jjob will immediately move over in spoolface. It's a good idea to reboot the printer after doing since
it may have gotten some partial print data in its memory that should be cleared.
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Spoolface error codes

When there is a problem printing, Spoolface usually reports a text or numeric error code that can be refer-
enced in this section.

Where is the error code?

The bottom left corner of spoolface shows the current spooler status or the error code of the most recent
failed job. (If you don’t see this status area, move the Spoolface window up a bit so it's not blocked by the
bottom of the screen. A status message will ALWAYS be n the very bottom left corner of the window, even if
it's not reporting an error.) Also--be sure to check the right (status) side of Spoolface for information regard-
ing printing errors, going from the bottom up. Look for anything in RED, and any messages that clearly state
that a licensing/dongle error has occurred.

ERROR 1

IPbatch.exe missing -- IPBATCH.EXE is a core ImagePerint file. Due to it's operation at a system level,
occasionally an anti-virus program may flag it as unsafe and delete or quarantine it, which will result in Error
1. Check that the file exists in your ImagePrint folder:

c: \ program files (x86) \ ImagePrint \ ipbatch.exe

If ipbatch.exe does NOT exist in that folder, check your anti-virus logs. It may be possible to restore the file
from your anti-virus program. If not, you can try restoring the file via an ImagePrint repair:

Right click your windows start men
Choose Apps and Features (or Programs and Features on some Windows systems).

Double-click the ImagePrint entry in the list of installed programs and choose to MODIFY, then REPAIR the
software.

If a repair fails, you may need to download and reinstall the software from ColorByte’s web site:

www.colorbytesoftware.com

Problem with printer name -- Error 1 can also occur if an illegal character (such as a space) was used in

the PRINTER NAME when installing via IPSetup, or if anti-virus software is running on your computer that is
interfering with ImagePrint’s printing processes. If you do have anti-virus software, try disabling it and see if

the problem persists.

If there are spaces or non-alphanumeric characters printer name you used when installing via IP Setup,
remove and reinstall the printer via the instructions earlier in this guide: Reinstalling your Imageprint Driver
- A Basic Walkthrough making sure not to use spaces in the printer name.

If removing and reinstalling the driver via IPSetup fails to solve the problem, try removing ImagePrint com-
pletely and reinstalling according to the instructions in the ImagePrint Users guide.

ERROR 2 or ERROR 15 (ImagePrint BLACK only )

This indicates a problem communicating with the printer. Make sure the printer is on and online. Make sure
that you specified the correct connection setting when installing ImagePrint (you can double-check this
by launching IP Setup and seeing what is listed in the Installed Printer’s area for your printer. The device
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selection will show up under the connection column--it will either be the port the printer is connected to (i.e. USB007)
or the name of the Windows Printer driver you chose when installing (ImagePrint will use whatever port that driver is
using when installed in this way) or the IP ADDRESS of the printer (if connected via Ethernet or WIFI to the printer).
If in doubt, try removing, then reinstalling printer using the instructions in the entry at the beginning of this
guide: Reinstalling your Imageprint Driver - A Basic Walkthrough or at the beginning of the Users Manual
found in your ImagePrint folder.

If you're sure the connection was specified correctly and you still get the error, you may have a device driver problem.
Try printing from the printer manufacturer’s driver via the Test Page option within the Printers and Faxes driver for that
printer. If that also fails, switch connection cables to ensure there is no problem there, and make sure to reboot both
the printer, and the computer to reset both interfaces.

ERROR 37

This indicates the dongle is not seen by the PC. No printing can take place without the dongle attached to a USB port
on the computer or a USB hub.

If the dongle is attached, launch IP Setup (from your ImagePrint folder) and see if the 6 digit dongle number appears
in the Dongle Number field. If the number shows up, then the dongle is being seen, and you should be able to print.

If the dongle number doesn’t appear in IP Setup, try unplugging the dongle and re-plugging it back in (or try another
USB port) then close and re-open IP Setup to see if the dongle number shows up. If that fails, reboot the computer
and check IP Setup again. If the number still fails to appear in IP Setup, run through the suggestions listed in the fol-
lowing entry of this guide: Dongle never shows up in IP Setup.

ERROR 97
This is usually a file access problem—the spooler is not able to access the file to be printed.

Make sure the file(s) to be printed is still accessible. Deleting a file or moving it from its folder after clicking PRINT in
ImagePrint before the image has actually printed can cause this condition as the Spooler will not be able to access
the file. Having your files on a cd, and ejecting the cd before the printing takes place, will cause this as well. All the
images on the page must remain in their original location while the page is printing.

If your images exist across a network, try moving it to a local directory and reprinting to confirm a network access
issue is not the cause.

ERROR 163
Error 163 can have a few causes. Below are the most common ones:

Paper Profile issue -- Make sure you have selected a paper profile via the Profile Valet in the Dashboard window in
Image Print and applied it. If the paper profile was selected on the Profile Valet but was not applied (by clicking the
Apply (or Download and Apply) button), the printer driver will be missing critical print parameter sand a job will fail,
possibly with error 163.

Profile Valet index not available -- Each time ImagePrint is launched, the Profile Valet connects to ColorByte’s
online profile site via FTP (File Transport Protocol) and downloads “index” files containing settings to use with each
available paper profile. Without these index files, you may get error 163 when attempting to print. Double-check that
the profile valet is working correctly in the dashboard (if you see profiles listed, it's working).
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Problems specific to the Epson P5000, P6000, P7000, P8000, P9000, P10000, P20000 and Canon IPF 1000, 2000,
4000, 6000

Wrong driver selected in IPSetup -- For these newer printers, you must have the manufacturer’s system printer
driver installed in order for ImagePrint to “find” the printer. This is done during printer setup via ImagePrint’s
IPSetup utility. If an incorrect choice was made (for example, if using P7000CE with Violet ink and in IPSetup you
chose the driver for the standard SureColor P7000) you may see an error 163 when attempting to print.

Malfunctioning manufacturer’s driver -- As mentioned, for the above listed printers, the Epson/Canon native printer
driver should be installed on the computer. You should also confirm that the driver is able to produce a test print.
if the printer is unable to produce a test print, you may need to redownload it from Epson or Canon and reinstall it.
Then remove/re-add the printer in IPSetup to re-establish ImagePrint’s connection.

Printer Sleep issue -- If your Epson P5000/6000/7000/8000/9000 printer was in energy saver mode when the
very first print was sent from Image Print, the print request will wake up the printer, but the printer may fail to
respond in time and error 163 may occur.. Simply un-pause the QUEUE in the Spool Face and try printing again.
(If you see issues sometimes when printing to a printer when it is asleep, wake up the printer by touching a button
on the printer before clicking Print)

ERROR 609

The image you are attempting to print is no longer is accessible. This can occur if you've deleted or moved the
actual images within a job before it begins to print, if you are reprinting old jobs from the SAVED side of spool-
face and the original images in the job have been moved or deleted, or if images located across the network are
no longer accessible across the network at print time. Loading images into ImagePrint from a CD, clicking PRINT,
then ejecting the cd before printing occurs would also cause this error. Try putting the image files contained in the
job back in their original folders if possible. Otherwise, you’ll need to layout the job in ImagePrint and print it again.
Don’t forget to drag the old (failed) jobs from the Active (top) side of spoolface to the Saved (bottom) and un-pause
the QUEUE via SpoolFace’s QUEUE menu before attempting another print.

ERROR 768
This error can have a few causes, usually related to settings within ImagePrint

- MOST COMMON: (ImagePrint BLACK only) In the Profile Section of the ImagePrint Dashboard a valid paper
profile should be selected and APPLIED that is correct for your printer and ink. The currently applied profile
will be shown in blue beside the word Printer Profile in the Dashboard.

- Check the DEFAULT PROFILES section of the ImagePrint Preferences window (chosen from the FILE menu
at the top of the screen) to, make sure that an appropriate source profile for your images is selected for
each color space that your images use within the Missing Profile/Untagged Images section (RGB, CMYK,
Grayscale). For printing single-channel grayscale images, make sure to pick either “gray gamma 1.8”,
or “gray gamma 2.2”, in the Grayscale field. It is almost always recommended that APPLY be set in the
Embedded Profile action field.
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Look in this section if you are able to print, but you have questions regarding the quality of the output.

My output is darker than it appears on screen

If colors are correct, but the overall print seems dark compared to the ImagePrint or Photoshop display, it is most likely
caused by your monitor being too bright. Calibrating your monitor may ensure color accuracy, but by default the cali-
bration software will not attempt to match the relatively dark look of a print ( which has no nearly pure whites or blacks
like those of a monitor display). Also, the brightness of the room you are viewing the print in is a factor that is very
hard to compensate for.

Many modern monitors are factory calibrated to be very bright. Even if you have custom calibrated your monitor, it is
very likely that it is brighter than the “standard” CRT monitor of the past.

One solution is to calibrate the monitor to a low luminance value, if your calibration software allows for that.

A simpler solution is to physically dialing down the brightness of the monitor, using it's on screen controls. Make a
print of an image, display the same image on the screen in ImagePrint, and then adjust the controls until the relative
darkness of the image on the screen matches that of the print. Write down the monitor settings--you can use those
whenever you are editing images for print, knowing that what you are seeing on screen is a relatively close match to
the brightness of the print.

Another cause of images appearing too dark when printed--especially for matte media--is lack of soft proofing when
displaying the image on screen. Softproofing simply means that the software you are using to view the image com-
pensates for the Paper/Printer/Inks in generating its display. Typically this is done via the Paper Profile you will be
using to output the image. When softproofing, the viewing software passes the image through the paper profile to
show you what the image will look like when printed. Typically this means less bright whites, less dark blacks, and a
reduced color gamut. If NOT soft proofing, the image is reproduced on your display without any compensation for how
it will look when printed, and since you might be printing on anything from high gloss film to newsprint, that means the
display may be a very inaccurate predictor of how your print will appear. Softproofing is important when editing your
images for print so you can compensate for the limitations the printing process introduces. This is most true for matte
papers which tend to reduce density and color gamut much more than photo papers.

For more information on Soft Proofing, please see Chapter 6, Color Management, in the Imageprint Manual--you can
get to it by choosing Help from ImagePrint’'s main menu.

Color cast in prints

Nozzles: As with any color issue, make sure you have done a nozzle check on the printer, and that all nozzles are
clean. Nozzle issues are the chief cause of color cast problems. For some printer’s it's not uncommon for an entire
ink channel can be blocked so make sure to count that all inks are represented in the nozzle check print.

Profile temperature (ImagePrint Black only): Colored inks invariably show some differences when viewed under dif-
ferent lighting conditions. ColorByte makes multiple color profiles for each media we support in order to optimize the
print for the environment it will be viewed in--for best results, you should use a profile built for the lighting it will end

up in. The two most commonly used profile temperatures are DAYLIGHT (targeting a daylight viewing environment)
and Mixed Hybrid Cool (F3) (targeting a cool white fluorescent mixed with daylight lighting environment). The Mixed
Hybrid Warm (F2) profile targets standard fluorescent mixed with daylight viewing environment). CWF is optimized for
Cool White Fluorescent lighting and TUNGSTEN profiles are optimized for viewing under tungsten lighting.
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Images are not centered on the page

In the following, orientation is always relative to the observer facing the front of the printer. For example, Top
refers to the leading edge of the paper as it comes out of the printer, Left refers to the left edge of the paper as it
comes out of the printer.

» Top/bottom differences on sheet paper: Many printers by design have different top and bottom margins when
using sheet paper. This can cause images to appear off center vertically when printed. (The Epson 2200, 2400
and 3800/3880 and P800 are exceptions. These printers allow equal top/bottom borders on sheet, but all other
Epson printers have a 1/8th inch top and 5/8ths bottom margin on sheet).

To compensate for this limitation:

If using ImagePrint Black you can choose Center Margins from the Margin Styles section of the
Dashboard. This will cause the size of the smaller top margin to increase to that of the larger bottom mar-
gin, reducing the total printable area while compensating for the difference in margins. If you then choose
to center your images, they should print with equal top and bottom borders. Make sure to readjust any
existing images on the page after changing this option, as the change in layout size will shift things. And
be aware of the smaller page size--with Centered Margins turned on, there is 4/8th of an inch less
vertical printable area available on the page for most Epson printers. The Centered Margins setting
has no effect when set to ROLL paper.

If using ImagePrint R.E.D. you will need to compensate for the difference in margins in the Windows
Printer Driver for your printer. Consult your printer manual if not sure how to set that option for your printer.

* Roll or sheet setting incorrect:

ImagePrint Black: Make sure you have made the right selection for roll or sheet in ImagePrint (via the
Roll/Sheet buttons in the MEDIA FEED section of the Dashboard) or centering issues may result. Also,
make sure that the correct TRAY option is selected in the MEDIA FEED section of the Dashboard when
printing on sheet paper. (Typical tray options are: ASF (Automatic Sheet Feeder), Manual, Front, or Back).

If using ImagePrint R.E.D. Roll/Sheet options are specified in the Windows Printer Driver for your printer.
Consult your printer manual if not sure how to set that option for your printer.

+ White border on images: Creating an image file with a white border around it is a common cause of center-
ing problems. Remember, ImagePrint will treat the image in its entirety, and has no way of knowing that a white
border is not part of the image. It will therefore place the image beginning at the edge of the white border, which
may cause unexpected positioning results.

» Paper size: Make sure that the actual size of the page you are printing on matches the page size specified
in ImagePrint Black (or in the Windows Printer Driver if using ImagePrint R.E.D.). Surprisingly, papers some-
times are shipped from the manufacturer with slight size differences. These can result in non-centered printing.
Measure the paper to ensure it is the correct size if you see an unwanted border. You can then use ImagePrint’s
User Defined page size window to define a page size that exactly matches the physical dimensions of your
paper.

* Incorrect paper loading: How you load the paper in the printer can make a difference in the margins. Make
sure that you are loading it according to the manufacturer’s instructions.

» Printer margin set incorrectly: Many printers allow you to set the margin for roll paper on their front control
panel. ImagePrint assumes this margin is at the lowest setting (typically 3 mm). Make sure that your printer
is currently set to the lowest roll margin setting or incorrect margins will result. (Typically, the Roll Margins set-
ting is accessed within the Printer Settings menu of the printer’s front panel. On Epson printers, the value with
the asterisk is the one in use--consult your printer manual for details on setting the roll margins for your specific
printer).
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I’'m getting an unwanted margin on my prints

In the following, orientation is always relative to the observer facing the front of the printer. For example,
Top refers to the leading edge of the paper as it comes out of the printer, Left refers to the left edge of the
paper as it comes out of the printer.

Borderless not set: If you want to print without any margin at all, make sure that borderless mode is enabled.
This is done in the MARGINS STYLE section of the Dashboard if using ImagePrint Black, or in the Windows
Printer Driver itself if using ImagePrint R.E.D. (To access the Windows Driver in ImagePrint R.E.D. click the
Setup... button in the Printers section of the Dashboard.

Remember--most printers only allow full borderless printing on roll paper, not sheet, paper. Also, only cer-
tain paper widths will print with no borders. Check your printer manual or the Printer Specific section of

the appendix of the ImagePrint User’s guide for information on the borderless capabilities of your printer.
Remember, if you see a pink border surrounding the layout area within ImagePrint then full borderless is not in
effect. Full borderless mode will show no pink border.

1/8th inch margin on left or right side: A border on the left or right side when attempting to print in
borderless mode is usually an indication that the image is incorrectly positioned on the page. This can hap-
pen if you switched to borderless mode after you have positioned your image on the page. In that scenario,
the layout area will have changed but the image will still be positioned at the edge of the original (bordered)
area. Always reposition (or remove and reopen) your images after making changes to the borderless set-
ting in either the Margins Style section of the Dashboard (ImagePrint Black) or the Windows Printer Driver
(ImagePrint R.E.D.).

1 to 2 mm “hairline”: Most inkjet printers can vary as much as 2 millimeters in the way they position the
edge of the paper. This can cause a thin line to appear on the edge of your full bleed prints. The “Global
Printer Compensation” controls, available in the Preferences window of ImagePrint (found under the
ImagePrint menu) can correct for this hardware variability. Setting a positive (right) or negative (left) X value
will move the entire layout at print time and allow you to correct for these “hairline” issues.

Printer margin set incorrectly: Many printers allow you to set the margin for roll paper on their front control
panel. ImagePrint assumes this margin is at the lowest setting (typically 3 mm). Make sure that your printer is
currently set to the lowest roll margin setting or incorrect margins will result. (Typically, the Roll Margins set-
ting is accessed within the Printer Settings menu of the printer. On Epson printers, the value with the asterisk
is the one in use--consult your printer manual for details on setting the roll margins for your specific printer).

I’'m getting a wasted strip of paper between each print
This usually means you are not set to the correct cut mode for your printer.

For ImagePrint BLACK, that setting is in the Options window (accessed by clicking OPTIONS in the
ADVANCED->PRINT SETUP section of the Dashboard).

For ImagePrint R.E.D. cut mode is set within the Windows Driver for your printer (if available).

“Normal-cut” is usually the safest mode--you'll get a small border at the end of your prints, but little to no
waste. “Double-cut” mode will usually cut each page precisely at top and bottom, but it does result in a few
inches of wasted paper between prints. “Single-cut” (for printers that support that option) attempts to cut
borderless prints exactly at top/bottom without a wasted strip of paper between prints. Single-cut mode

is often a bit finicky and in our experience often reverts to double-cut mode on many printers. Look in the
ImagePrint manual’s Printing chapter for more information on Cut Modes. (Some older printers, such as the
Epson 4000, 7600 and 9600, are not supported for single-cut mode and will always have some wasted paper
between prints when printing in borderless mode).
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ImagePrint Black: Print-length issues are typically due to problems with the printer’s paper feeding controls.

There are only two controls that ImagePrint has for paper feed:

Media Type: The Media Type menu within the Dashboard -> ADVANCED -> PRINT SETUP ->

Options dialog (for printers that support it) allows you to choose a pre-set within the printer for different
media types. For thicker papers, select the closest match to your paper to ensure that paper is fed cor-

rectly. (Ultra Smooth Fine Art Sheet is typically the thickest option available.)

IMPORTANT: Changing the media type from the default in this way may adversely affect print quality for
printers that also use the media type setting to specify inking characteristics. Newer printers such as the
Canon 1000, 2000, 4000 and 6000, and the Epson P5000, 6000, 7000, 8000, 9000, 10000 and 20000 use
the media type setting to set inking characteristics.

Media Feed Adjustment: If available, increasing the Media Feed Adjustment setting (also in the

Dashboard -> ADVANCED -> PRINT SETUP -> Options dialog) can have the effect of lengthening the
print by increasing the distance between printer passes. This slider rarely needs to be adjusted, but for
very long prints on heavy papers (like canvas) it can help to compensate for problems with the printer’s
paper feeding.

ImagePrint R.E.D. Controls that affect print length of handled by the Windows Driver for your printer and can
vary from printer to printer. For more information on common settings for Epson and Canon printers, see the

Appendix of the ImagePrint Users Manual, available via the HELP menu when in ImagePrint.

The last few lines of my prints fade or don’t print

Wrong paper size (length): This condition can be caused by an incorrect page size setting. If the page

size you have selected is larger than the page loaded in the printer, the page may eject before the last bit of
the image is printed. Measure the physical page to make sure it came from the manufacturer at the correct
length--papers are often slightly smaller than the specified size (in which case you can specify a smaller page

size in ImagePrint’s User Defined page size dialog box).

Jobs print distorted or as negatives

Layers: Flatten your image and try printing again.

Channels: Prints that appear reversed or negative may be due to extra channels in the image (open the
image in Photoshop and check, in the Channels window, that only the normal color channels appear)

Pixel Order: For Tiff files, make sure the PIXEL ORDER setting is interleaved (NOT “per channel”). This can
be checked in the Photoshop SAVE dialog.

Corrupt File: Rarely, a corrupted file can print with distorted results. Make sure to try printing a different file,

such as one of the sample images within the TEST IMAGES folder within your ImagePrint folder.

Nozzles: You may also get this result if there is a severely clogged nozzle. Do a nozzle check on the printer

to ensure the nozzles are all clean.

Incorrect Printer/Paper profile (ImagePrint BLACK only): Choosing a “Phatte black” profile when you are
not using the Phatte black ink set can cause distorted prints, as can doing the opposite (printing with a non-

phatte black profile when you ARE configured for Phatte black).

No source profile or incorrect source profile: If your images don’t have embedded profiles, make sure
you have a valid profile setting for untagged/uncolormanaged images in the Default Profiles section of
ImagePrint’'s Preferences window. Don’t use a “dot gain” profile for grayscale images--Gray Gamma 2.2 or
another gamma based profile should be used.
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Prints show banding (lines)

Nozzles: The first thing to check if you are experiencing banding issues is the nozzles of the printer. This is
by far the most common cause of this problem. Even one missing or incorrectly firing nozzle can cause unpre-
dictable banding. Run a nozzle check, and, if nozzles are missing or incorrectly aligned, run printer cleanings
until it is corrected. (Note that ImagePrint, due to its enhanced ability to render detail, may show banding due
to nozzle issue when the standard manufacturer’s driver doesn’t).

Speed: Giving the print more time to absorb the ink as it prints by setting the Speed to a higher number of
passes may cure banding issues. You can change the speed in the ADVANCED -> Print Setup section of
the Dashboard if using ImagePrint Black, or in the Windows Driver for your printer if using ImagePrint R.E.D.
Going from 4 pass to 8 pass will effectively double the print time. Also, if you are set to a HS (high speed)
quality mode, try a non-HS Quality to allow the print more time to absorb the ink.

Media Type:

ImagePrint R.E.D.: The Media Type setting affects paper thickness controls on the printer. If using
ImagePrint R.E.D. you need to pick the Media Type within the Windows Driver settings for your printer.
(Access the Windows Driver by clicking “Setup...” in the Printers section of the ImagePrint R.E.D. Dashboard.
) Trying a different Media Type may improve paper feed and banding issues, but it can also affect color den-
sity of your prints and may cause a different ICC paper profile to be used in ImagePrint.

ImagePrint Black: The Media Type setting affects paper thickness controls on the printer--with ImagePrint
Black it is automatically selected when you pick a paper profile, but if your printer shows banding you may
want to try a different Media Type to compensate for printer feed issues. This is especially true for older print-
ers (prior to the Epson P-series). The Media Type setting is found by clicking OPTIONS in the ADVANCED-
>PRINT SETUP section of the Dashboard.

IMPORTANT: Changing the media type from the default in this way may adversely affect print quality for
printers that also use the media type setting to specify inking characteristics. Newer printers such as the
Canon 1000, 2000, 4000 and 6000, and the Epson P5000, 6000, 7000, 8000, 9000, 10000 and 20000 use
the media type setting to set inking characteristics.

What do Passes (4-pass, 8-pass, etc.) mean in the Speed or Quality listing?

Many printers have the ability to move the print head over the same area of the paper, firing different nozzles
each time. The higher the number of passes, the more times the head will pass over the same area of paper,
firing fewer nozzles with each pass. In the end, passes don’t make a difference in terms of what gets put on
paper--the same dots will be put in the same place--they will just take a longer (or shorter) time to get there.
But more passes will give the ink droplets more time to soak into the paper. This reduces the chances of
droplets coalescing on the surface of the paper, which is a cause of inking problems on the print such as
banding, artifacts, or smudges.

Higher pass settings make a very significant speed difference, though--doubling the passes (say, from 4-pass
to 8-pass) doubles the print time. So you should use a lower pass setting as long as you don’t see inking
issues.

For most printers that support it, the default pass setting that ImagePrint uses is 4-pass.
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What does HS mean in the Speed or Quality Listing of the Print Setup area of the Dashboard?

HS in the quality name means “High Speed” or bi-directional printing. In this mode, the print head will put ink
on paper in both the directions that it moves across the page. (Non-HS mode printing only puts ink down as

the print head moves away from its original home position). The ultimate position and size of the droplets on
the page will be the same in the end--HS just puts them there more quickly.

Bi-directional (HS) mode does significantly improve speed (by a factor of 2), but on some papers (typically
glossy ones) it may not provide enough time for the ink to settle into the paper before more ink is laid down,
resulting in potential banding, smudging or artifacts in the print. Also the print head isn’t perfectly registered
you may seen alternating patterns of light and dark areas on the print. For slower computers or connections,
you may find that the printer is more likely to pause when printing in HS mode as it waits for more data from
the printer.

As with most Quality settings, use of HS mode is a matter of using it if you see no negative results. In most
cases, it is perfectly fine and will double your printing speed with no loss in quality.

What Quality value should | use when printing? (28807 14407 Photo? Best?)

The Quality values (which will be determined by the Printer/Paper profile you choose) refer to the droplet size
used by the printer. Typically, these are numeric values that refer to the number of droplets per inch, but for
some printers the qualities modes have names instead (such as BEST, PHOTO, FINE, etc.)

Smaller droplets sizes aren’t necessarily the best mode to use. For example, 2880 is a very fine dot, but
doesn’t allow for variation in the droplet size on most printers, so, it isn’t necessarily “better” than 1440 (which
does allow for size variation) since the ability to produce variable dot sizes can make a significant difference
in the smoothness of the dot pattern produced on the paper.

In most cases, ImagePrint’s profiles will be made for 1440 (on some printer’s, this is referred to as PHOTO
quality). 2880 profiles may also be available, but due to the much slower print speed and dubious improve-
ment in quality at normal viewing distance, they are typically made only for some gloss papers (matte papers,
with their large dot spread, tend to lose any advantage the smaller droplet size might provide).

Lower quality modes, like 720, may be available as well. Generally, 720 quality produces output that’s slightly
grainier and more susceptible to banding.

What Resolution (PPI) should my images be saved at for best results?

Every print driver takes all the images on a page and builds a large raster (dot) image that is sent to the print-
er. Regardless of the PPI (pixels per inch) of the images on the page, the information will be converted to the

one of the printer’s “native” resolutions at print time. You can set this resolution via the DITHERING DPI set-
ting available in the ImagePrint Print dialog.

Note that this printer PPl is distinct from the quality that the printer is driven at. The quality setting for the printer
specifies the size of the droplets (typically, specified in droplets per inch) that the printer will use to render the
image on the page. Since the printer uses multiple droplets to present each pixel of the image, the quality that
the printer is capable of doesn'’t translate to the PPI of the image data that is sent to it. For example, a printer

might print 1440 droplets per inch, but within that inch, only 360 pixels of image data are represented.

ImagePrint can open images of any resolution, but it will interpolate them to the printer’s native resolution (the
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Dithering DPI) at print time. (ImagePrint uses bi-cubic interpolation when scaling images).

Since the RIP will interpolate the images to the native printer PPI, there’s no benefit for your images to be a

higher PPI than that setting. In fact, anything above 240 PPI or so doesn’t show any improvement on ink jet
printers. (This is 240 PPI at the printed size--if you're scaling the image, of course, you’ll want to start with a
higher resolution.)

Therefore, as long as your image is 240 PPI or above at its printed size, your prints will be at their best qual-
ity. Giving us images at a higher PPl won’t hurt, but they won’t make a noticeable improvement on your output,
either for photographic images. (The exception to this rule is when your images are vector (line work) images.
Single pixel lines, when interpolated, may result in unwanted moire type patterning--therefore, it is often best to
provide computer generated line work at the native resolution of the printer).

For most printers, 360 or 300 are the standard PPIs used--you’ll see one of those by default as the Dithering DPI
in the ImagePrint Print Dialog. A lower setting (such as 180) may result in slightly faster processing speeds, but
can show a slight (although typically very small) increase in “graininess”. It is therefore only recommended that
larger (5 feet+) images use the lower PPI settings instead of the default 360 (or 300). At larger sizes, the slightly
more grainy output typically isn’t noticeable, as prints of that size are usually meant to be viewed at a distance.

Where should | scale my images--Photoshop, ImagePrint, or using a specialized program?

Because of the relatively low-resolution of an inkjet printer, it is doubtful you will see any difference between
images scaled via Photoshop, ImagePrint or a specialized program if you are doing no more than doubling the
size of the original image. (You may want to try some sample prints utilizing different methods to find what is best
for your workflow.)

One benefit of scaling images in ImagePrint is that you then won’t have to produce a “print ready” copy of the
image. ImagePrint will scale the image “on the fly” with no need to save a 2nd copy at the desired print size.
Also, when scaling the images, ImagePrint uses bi-cubic interpolation at the final (dithering) stage of rendering
it for print. Doing the scaling late in the process is a benefit, as it allows all other image processing to be per-
formed on the original (un-interpolated) data.

ImagePrint does -not- currently apply any sharpening to images during scaling, which may be a factor if you are
scaling your images more than twice their original size. In those cases, you may wish to use Photoshop or a
specialized program like Genuine Fractals to scale your images. (This is especially true if you are blowing the
image up 4 or 5 times it’s original size. )

Again, it is often best to print some samples using different methods of scaling/sharpening to ensure you’re not
doing more work then you have to achieve the same print quality.

What is gloss differential?

Gloss differential is the effect of inked areas of a print having a different gloss (or shine) then non-inked portions.
The problem is predominately seen on glossy papers, and is usually noticed as white areas of the page appear-
ing more shiny then the non-inked areas when the paper is viewed at a slight angle. Matte paper does not show
this effect to any noticeable degree.

Gloss differential has been reduced with newer ink sets on some printers (the inks maintain a gloss that more
closely matches that of the paper).

Laminating, or spray coating, the print will eliminate gloss differential.
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What is bronzing?

Bronzing is often described as a golden or bronze “sheen” seen on a print where the dark areas take on a flattened
appearance when the media is held at an angle. It only occurs on papers with a gloss coating (not on matte) and
is not visible when the print is viewed directly (straight on). It is strongest in the dark areas of the print and is most
noticeable with black and white output, where heavy use of black ink occurs.

Some Epson printers employ a lite-lite black ink that greatly reduces the bronzing effect. Because of this, ImagePrint’s
phatte black option (which makes no use of the lite-lite black) may show more bronzing on black and white prints on
glossy papers than non-phatte black prints.

Laminating or spray coating the print will eliminate the bronzing effect.

What is metamerism and color inconstancy?

Color inconstancy is the phenomenon of an object (in this case, an ink jet print) showing different color casts when
moved from one light source to another. For instance, taking a print from daylight to fluorescent light will cause the
print to often appear more warm. Metamerism is a similar concept, and the two terms are often used interchangeabily,
but metamerism is actually a reference to the amount of observable color difference between two objects, and how
that difference changes under different lighting. Both phenomenon are much more apparent in colored inks than gray/
black inks, so the effects are more prominent on color prints then black and white. ImagePrint’s black and white print-
ing (using a “gray” printer profile), makes use of very little color ink and shows virtually no metamerism or color incon-
stancy.

For color printing, ImagePrint provides printer profiles optimized for different lighting conditions. This can help to
optimize your output for the viewing environment it will be displayed in--you can see which light a profile is made for
by looking at the abbreviation at the end of the profile name, such as “DAY” for daylight, or “CWF” for “Cool White
Fluorescent”. More information on profiles names can be found later in this guide in the entry entitled: What do the
profile names mean?
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If images aren’t displaying on screen properly within ImagePrint, look here for solutions

Images appear split, reversed or in triplicate on screen

This condition can occur if you do not have a proper source profile chosen in the Profile section of the
ImagePrint PREFERENCES window (Preferences is found under “View” in the main menu at the top of the
screen). This problem is most often when using a grayscale paper profile or opening a grayscale image. Make
sure to have a valid gray profile selected in the Missing Profile section’s Grayscale field (either “Gray gamma
1.8” or, most typically, “Gray gamma 2.2”). Also, you should make sure the Embedded Action field is set to
APPLY if using embedded profiles in your images. Without a source profile chosen, the software will have
no way of determining how to map the single channel grey data to the 3 color screen display, and distor-
tion will result.

Also, in the same window, the “Simulation” profile should be set to NONE unless you are specifically trying to
cause your output to match to a press (in which case the press profile can be used there).

In the vast majority of printing workflows, the Simulation profile should always be NONE.

Another common cause of Image display problems can be incompatible layers in the file. Try flattening the
image.

Extra channels can also cause issues. In Photoshop, choose Channels from the Windows menu and make sure
that only the standard color channels are present (no masking channels or non-color channels).

Images appear scrambled, low resolution, or full of artifacts

» Extra channels in the image may cause it to display incorrectly. To check this, open your image in Photoshop
and check in the CHANNELS window that only the normal Color channels appear (no masking layers or
other non-color channels should be in the image).

» Some layers may cause problems. Try saving a flattened version of the file from Photoshop.

* If no extra channels appear, and it is flattened, and it is a tiff file , try re-saving the image from Photoshop,
and in the Save... dialog box, make sure the “Pixel Order” is “interleaved” (not per channel) and that NO com-
pression is being used.

+ If the display appears low res, check in the ImagePrint Preferences window (available under the View menu)
that you are set to the highest resolution in the Preview Size menu. After setting the Preview size, use the
scissors (in the floating toolbar) to delete the image from the page, then reopen it to see the effects.

* Remember, to get a higher resolution preview of the image, you can right click it and choose High Resolution.
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Colorized B/W Images appear gray on screen (ImagePrint Black Only)

This is normal behavior. On screen, the colorized image will display using only the GRAY profile, but when
printed, the colored portions of the image will use the selected COLORIZED B/W profile.

Colorized B/W Images appear distorted (ImagePrint Black Only)

This is usually the result of the image being 16 bit, or containing an Alpha channel. Only 8 bit RGB images,
with no alpha channels, are supported with this feature.

Two monitor system and ImagePrint’s colors are not displaying correctly

If you are using a two monitor system, it is important to understand that ImagePrint will only recognize the
monitor profile for your System monitor. Therefore, if ImagePrint is residing on a secondary display, the mon-
itor profile may be incorrect because ImagePrint will be using the System monitor’s profile, not the secondary
monitor’s profile.

A workaround is to designate the secondary monitor’s profile as the System monitor profile in your Windows
Display Control Panel to ensure ImagePrint always uses it. In other words, by setting both monitors to use the
secondary monitor’s profile, ImagePrint will always use the secondary monitor’s profile. Of course this means
the primary monitor will be using an incorrect profile so its display may show some slight color inaccuracies,
but usually it's not noticeable if that monitor is not used for color critical work.
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Profiles & Color Management

Problems and questions related to ICC/ICM color management and profiles, and issues with the Profile
Manager utility are discussed here

My printed colors/tones don’t match my display

Printed output not matching the display on the monitor is one of the most common frustrations in any work-
flow. Following are the most common causes of this problem and their solutions.

Remember---ImagePrint is always soft proofing, meaning it is passing its display through the printer profile.
Your display in ImagePrint should look close to your print if you are using a calibrated monitor and your set-
tings are correct. As a test, always look at the display in ImagePrint and compare it to the print--don’t just
compare it to the display in Photoshop. For soft proofing issues within Photoshop, make sure to also consult
the entry in this guide entitled: Photoshop doesn’t match my output (softproofing)).

* Nozzles: First and foremost, make sure you have performed a nozzle check on the printer and that no
nozzles are clogged. Clogged nozzles are the number-one cause of color issues.

* Incorrect ImagePrint Color Settings: Double-check your color management settings. Chapter 6 of the
ImagePrint users manual discusses Color Management settings in detail, but here’s a check list:

Output Profile Settings

ImagePrint Black: In the ImagePrint Dashboard, in the PROFILES area (either the Profile Valet or

the I(;r:joose by Profile section) Make sure a correct printer/paper profile is selected for your paper and
applied.

ImagePrint R.E.D.: In the ImagePrint Dashboard, in the PRINTER area make sure you are in the
correct color management mode (typically “ImagePrint Manages Colors” and that you are set to the
right profile in the Using Profile... menu. &,f using a paper made by your printer maker, it should be
Automatic--if using a 3rd party paper you should have the proper paper profile chosen.) More info on
this setting can be found in chapter 6 of the Users Manual.

Source Profile Settings

To confirm your source profile settings, in ImagePrint Preferences (found by choosing View in the Main
Menu), choose Default Profiles and:

- Make sure Embedded Action is set to Apply

- Make sure that your normal working spaces are selected in the Missing Profile o
section for each color type. These will be used as defaults if no embedded profile exists in an
image.

- The Simulation Setup profile should be NONE unless you are intentionally trying to match
your output to a press. In almost all cases, when printing photography, leave this setting at
none (The Intent setting won’t matter).

- The Colorized Profile (ImagePrint Black only) should be empty in most cases unless you
are using a gray printer profile and want some portions of y our image to use the color profile
selected here. More information on Colorizes B/W can be found in chapter 6 of the Users
Manual.

+ Two Monitors: If you are using a two monitor system, it is important to understand that ImagePrint will only
recognize the monitor profile for your System monitor. Therefore, if ImagePrint’s display is residing on a
secondary display, the monitor profile may be incorrect. It may be necessary to designate the secondary
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monitor profile as the System monitor profile to have ImagePrint show colors properly on the second moni-
tor.

» Too Dark: If hues are fine, but overall darkness is the issue, it’s likely that the screen is too bright even if
your monitor has been calibrated. When LCD monitors became the norm, this became a common prob-
lem as LCD’s are factory set in almost all cases to be brighter than CRTs, and calibrating doesn’t bring the
gamma down enough to match the brightness of most viewing environments. The solution is to calibrate
to a lower luminance, or simply tone down the brightness with the monitor’s brightness controls to match a
print, then use those settings each time you edit images for printing.

* Incorrect Soft Proofing: ImagePrint’s display always soft proofs, so it should always match your print rea-
sonably well on a calibrated monitor. Photoshop’s display only soft proofs when you have set Photoshop
to do so--otherwise, it will display the image with absolutely no allowance made for the paper and inks you
are using, displaying the image the same for a watercolor paper as it would for a high-gloss film. Check
the section later in this guide entitled: Photoshop doesn’t match my output (softproofing) for details on soft
proofing with Photoshop.

* Wrong Lighting (ImagePrint Black only): The ink used in inkjet printers always exhibit some level of
color inconstancy (the tendency to look different under different types of light). Make sure to use the
right profile for the lighting you are viewing your color prints in (for example, a print made using a profile
with “day” in the title is optimized for daylight viewing). For more information, consult chapter 6 of the
ImagePrint user’s guide. For information on the profile names, check the entry entitled What do the profile
names mean later in this guide.

* Wrong side of the paper: Don’t be embarrassed by this one--it happens to us too. It's sometimes very
hard to tell which side of the paper to print on. Make sure you are printing on the coated side (as a test,
touch a wet finger to each side of the paper--the stickier side is usually the coated (printable) one).

* Phatte or non-phatte (ImagePrint Black only): For some printers, ImagePrint supplies “phatte” profiles,
made for printing in our special phatte-black mode. These profiles will always have “dk” in the title instead
of the usual “pk” (photo black) or “mk” (matte black). If you are not using a phatte black ink cartridge in
your printer, do not use a profile with “dk” in the title. Alternatively, if you ARE set up for phatte black,
ONLY use profiles with “dk” in the title.

+ Somebody else’s printer profile (ImagePrint Black only): Printer profiles don’t just characterize paper
and ink. They are a fingerprint of how a RIP or driver lays down ink. Therefore, never use a profile
made for another RIP or the manufacturer’s driver with ImagePrint (or vice-a-versa) or incorrect colors will
result. If you create your own profiles for use with ImagePrint, make sure to create them by printing an
un-color managed profiling target from ImagePrint according to the instructions in the ImagePrint Manual’s
Appendix.
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| downloaded a profile but don’t see it in the printer/paper profile list (ImagePrint Black)

Restart ImagePrint: Make sure you have restarted ImagePrint since downloading the profiles--ImagePrint does not
automatically detect newly added profiles until it is restarted.

Pick the right printer!: ImagePrint only shows profiles that are valid for the currently selected printer--make sure, in
ImagePrint, the printer you have selected at the top of the ImagePrint Dashboard is the right one for the profiles that
you downloaded. Be careful that you download the right profiles, too--it is easy to accidently download profiles for an
“X880” printer instead of an “X800” printer, for example. In almost all cases we’ve seen where profiles didn’t appear to
have downloaded, it’s because the wrong printer was picked.

Look for the description, not the profile file name: When downloading profiles, the Profile Manager displays the
profile’s file name in its list. However, within ImagePrint's Choose by Profile section of the Dashboard’s Profile area
you will be seeing the internal description of the profile, which may differ significantly from the file name (the file
name tends to be more abbreviated due to constraints in the number of allowed characters). Remember, the Profile
Manager also shows the profile description of the currently selected profile at the bottom of the profile listing.

Windows “Virtual Store”: Windows may be redirecting the profile downloads to your Windows “Virtual Store”
folder--this happens as a security measure on some Vista and Windows 7 systems when utilities such as the Profile
Manager are not granted permissions to download files to ImagePrint’s Color folder. The quick workaround is to
always launch Profile Manager by right clicking its icon and choosing “Run as Administrator”’. Another workaround
would be to disable your UAC (User Account Controls) via your “User Accounts” control panel, though this may make
your Windows system less secure.

| can’t find the paper profile | need (ImagePrint Black)

First, make sure to use the Profile Valet (if applicable) or the Profile Manager utility to check our site for the profile.
Instructions on use of the Profile Valet and the Profile Manager are contained in chapter 6 of the User’s Guide, or
within the Profile Manager’s HELP menus.

If you don’t see a profile for the paper you are using on the ColorByte Profile site, we may not have it. Send an email
to the ColorByte Support dept. at support@colorbytesoftware.com with the exact paper name, the printer you plan to
use the profile with, the black ink you are using if applicable (i.e. photo or matte black) and your 6-digit dongle num-
ber. We will check to see if we have the profile available (maybe we just haven’t uploaded it yet)--if not, we may ask
you to send us some of it so we can generate a profile.

ColorByte may generate profiles for free if:
We don’t already have a profile available
The media you wish to have profiled is a valid one for your printer

You can supply us with some of the paper (typically the equivalent of 3 11x14 sheets or larger per profile--6 if
you need both gray and color profiles) in perfect condition to use for the generation of the profile.

IMPORTANT: Even if the above applies, we do not create profiles for uncoated papers, transparencies, or most
“unusual” media such as metals. Profile generation times vary greatly depending on ColorByte’s volume, but typical
turn around time is about two weeks.

In some cases, rather than get samples of the media, we will ask you to output our profiling target and send it to us-
-ColorByte will let you know exactly how to do that if it is necessary.
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I can’t find the paper profile | need (ImagePrint R.E.D.)

ImagePrint R.E.D. does not supply paper profiles. Instead it uses profiles made by the paper manufacturer. Check
with your paper maker for the paper profiles for your particular media. Usually they are downloadable from their
website. Note that ImagePrint R.E.D. typically only needs the ICC profile--not the media configuration file the paper
maker may offer.

The profile should go in the standard location for profiles on windows. On most systems, you can simply right-click
the ICC profile and choose to “Install” and Windows will place it in the proper location automatically. If you need to
copy it in manually, the default location for profiles on Windows is:

/Windows / System32 / Spool / Drivers / Color

Once the profile is in the proper location, it can be chosen in ImagePrint R.E.D. via the “Using Profile” menu in the
Printer Section of the Dashboard. Remember, you'll also need to select the correct Media Type for the paper you are
using in your printer’s System Driver by clicking Setup... in the Printer Section of the Dashboard.

What do the profile names mean? (ImagePrint Black)

If using the new Profile Valet, you won’t usually need to be concerned with the profile name, but if using an older
printer or if you don’t have an internet connection at your ImagePrint computer, you may need to use the Choose by
Profile method of selecting your profile--the following information should be helpul in making sure you pick the right
one.

ImagePrint’s profiles start with the PRINTER NAME (abbreviated), followed by the INK SET used for this profile (mk
is matte black, pk is photo black, dk for “Phatte Black” (dual black) mode)). Next may come the VERSION LETTER
of the driver (currently “b”) they are made for, then the PAPER TYPE (sometimes very abbreviated) and the QUALITY
at which they were made (if no quality appears in the name, assume 1440 for most printers. The Quality setting
refers to the droplet size the printer will use, as well as the number of passes and HS (high speed) mode.). You may
also see a number (i.e. “6”) indicating which version of our profiling target (not which version of Imageprint) was used
to generate the profile. The designations at the end of the name refer to the lighting temperature the print will be best
suited for.

What are the LIGHTING designations within the profiles? (ImagePrint Black)

The designations at the end of the printer/paper profile name refer to the lighting temperature the print will be best
suited to be displayed in.

Inkjet printers often exhibit color inconstancy (which is the characteristic of a print changing its appearance as it is
moved to different lighting conditions) so ColorByte gives you a few choices to enable you to pick the conditions that
most closely will match where the print will be viewed. (Although you can’t always know where a print will be viewed,
having the ability to choose the temperature can make a big difference. If you know your print is going to viewed in
a museum that uses Tungston lighting, you can pick the profile that will show it best there. If you are planning on
hanging your print near a window, the Daylight profile would show it best.).
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Not all lighting temperatures will necessarily be available for each profile made.

The current temperature abbreviations are:
ETUNG Tungsten

EDAY Daylight (Most printer drivers only supply daylight optimized profiles, so this type may be best
for an “apples to apples” comparison of ImagePrint prints to prints done via other methods).

ECWF Cool White Fluorescent

F2 Fluorescent, alternate version (this version is a bit less warm than our standard ECWF profile,
some people, especially portrait photographers, prefer it). This temperature was previously
abbreviated with “ECWF2”.

F3 Mixed lighting (daylight with fluorescent). This the best profile to use for general lighting con-
ditions, such as that found in offices. (NOT AVAILABLE FOR ALL PRINTERS and PAPERS)

ImagePrint doesn’t match my Photoshop display! (ImagePrint Black)

This entry addresses the use of soft proofing within Photoshop to ensure the Photoshop display is compensating
for the printer, ink and media being used when printing. For problems with the appearance of the prints them-
selves, consult the portion of this guide entitled My prints don’t match my display.

If Colored Images don’t show the same colors as Photoshop’s display...

By default, Photoshop does nothing to compensate for how an image can print on a given output
device. It has no idea of the printer’s gamut, or the media (matte or gloss), or what ink you are
using, or even the capabilities of the RIP--even though all of those factors have a tremendous affect
on what colors and densities you will be able to print. Photoshop just displays the image as best as
it can within the gamut of the monitor. It's therefore no wonder that Photoshop won’t automatically
match the output of your printer, especially if you are using a RIP (like ImagePrint) that maximizes
the output capabilities of the device rather than restrict it to a monitor-like color space.

You can, however, tell Photoshop to use ImagePrint’s color profiles when creating its display, allow-
ing you to work in a Photoshop environment that reflects more closely how ImagePrint will print your
files. This is called Soft Proofing, and is done via the PROOF SETUP feature of Photoshop.

To cause Photoshop to pass its display through ImagePrint’s printer profile, you must first copy the
printer profile you are using in ImagePrint into the color profile folder used by Photoshop.

The ImagePrint Profile Manager can do this for you. Just choose the profile on the left side of the
profile manager window, then choose “Install profile for Photoshop soft proofing” from the File menu.
For information on the Profile Manager, check out the Color Management section of the ImagePrint
Users manual.

If not using the Profile Manager, you can copy the profiles in to place manually by right-clicking
them, and choosing “Install” in the menu that appears.
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Once in place, this profile can be selected within Photoshop via Photoshop’s Proof Setup option. By
choosing View->Proof Setup in Photoshop, then clicking the CUSTOM button, you can choose the
Imageprint profile, causing Photoshop to bring it's display within the gamut of the printer/paper/ink
and RIP.

Note: There are other options within the Proof Setup window that may or may not have an effect

on matching your output (such as simulate paper white). The best way to determine which fea-
tures to turn on is to print a sample image from ImagePrint, then compare it to the screen display of
Photoshop with Proof Setup in effect. Try the different options, and use the ones that cause the dis-
play to most closely match the print.

Note: If you find that ImagePrint shows more shadow detail than you are used to in Photoshop, you can increase the
darkness of the prints, at the possible expense of losing some shadow detail via the Shadow Point Compensation
slider, located in the Output section of the Color Management window. Note that setting the INTENT for the
colorspace of your image to RELATIVE COLORIMETRIC (within the Bitmap section of the Color Management window)

will make the Shadow Point Slider’s effects much more dramatic.

If Grayscale images don’t look the same in Photoshop as in ImagePrint...

For grayscale printing, Photoshop’s Proof Setup cannot be used with ImagePrint’s current grayscale pro-
files, as Photoshop does not recognize the format of those profiles (this may change in the future). In that

case,

Photoshop Adjustment Layers can be used to simulate ImagePrint’s output in Photoshop. Here’s

the procedure to follow:

Print an image through ImagePrint, then open that image within Photoshop.
Choose Image->Curves from the Photoshop menu.
Adjust the curve to match your ImagePrint output.

Once you have a curve that causes the on screen image to match the print, click the Save button
within the Curves dialog box, and save the Photoshop curve as an adjustment layer (you may wish
to give it the name of the media you are matching).

You can create multiple adjustment layers in this way, each characterizing a different media output
of ImagePrint.

To enable/disable a particular adjustment layer, simply click the layer visibility icon (an eye symbol)
within the Layers palette of Photoshop. This will allow you to work in a Photoshop environment
that simulates how ImagePrint will print for that particular media.

Important: When saving the image, you should make sure that none of these custom adjustment
layers are enabled in the layers window (the “eye” icon should not be beside any of them). This will
ensure that the information in that layer is not saved with the image, which would be undesirable as
the adjustment layer is used to adjust the Photoshop preview only, and should not be applied to the
image data itself.
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Where can | put profiles to have Photoshop see them for use in Soft Proofing? (BLACK)

Color profiles must be copied from the Color folder, which is located in the ImagePrint folder into the folder that
Photoshop uses for 3rd party color profiles.

The ImagePrint Profile Manager can do this for you. Just choose the profile on the left side of the profile man-
ager window, then choose “Install profile for Photoshop soft proofing” from the File menu. For information on the
Profile Manager, check out the Color Management section of the ImagePrint Users manual, or consult the entries
related to the Profile Manager elsewhere in this guide. If not using the Profile Manager, you can copy the profiles
manually. The location they should be placed in is:

On Macintosh OSX the folder is:

llibrary/application support/adobe/color/profiles
On Windows the folder is:

Iwinnt/system32/spool/drivers/color
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